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Read This First

Welcome to the Thermo Scientific™ Q Exactive™ GC system! 
Q Exactive GC is a member of the Thermo Scientific family of mass 
spectrometer (MS) detectors that are powered by Orbitrap™ technology.

About This Guide
This Q Exactive GC Software Manual provides reference information 
about the parameters in the Instrument Configuration window, the 
Instrument Setup window, and the Q Exactive GC Tune window. For 
information about the operating procedures for the Q Exactive GC 
mass spectrometer, we recommend that you read the Q Exactive GC 
Operating Manual in its entirety.

Who Uses This Guide

This Q Exactive GC Software Manual is intended for all personnel that 
need to perform measurements with the Q Exactive GC mass 
spectrometer, especially the key operator. This manual should be kept 
near the instrument to be available for quick reference.

Scope of This Guide

The Q Exactive GC Software Manual includes the following chapters:

• Chapter 1: “Instrument Configuration Window” describes the 
Instrument Configuration window, which displays configuration 
information.

• Chapter 2: “Q Exactive GC Readback Status Page for the 
Information View” describes the page that allows controlling the 
instrument from the Roadmap view of the Xcalibur™ Home Page 
window.

• Chapter 3: “Instrument Setup” describes Instrument Setup, which is 
used to specify instrument settings.

• Chapter 4: “Explore Q Exactive GC Tune” provides information 
about Q Exactive GC Tune, its views, functions, and features.

• Chapter 5: “Procedures in Q Exactive GC Tune” provides 
information about procedures in Q Exactive GC Tune.
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• Chapter 6: “Reference Information” provides information about 
various file types and other supplemental information.

Related Documentation

In addition to this guide, Thermo Fisher Scientific provides the 
following documents for the Q Exactive GC mass spectrometer:

• Q Exactive GC Preinstallation Requirements Guide

• Q Exactive GC Quick Start Guide

• Q Exactive GC Operating Manual

• Manuals for the delivered ion sources and other software.

You can access PDF files of the documents listed above and of this guide 
from the data system computer. The Q Exactive GC Tune software also 
provides Help.

❖ To view product manuals

Go to Start > Programs > Thermo Exactive Series > Manuals.

❖ To open Help

• From the Q Exactive GC Tune window, choose Help > Help 
Content.

• If available for a specific window or dialog box, click Help or press 
F1 for information about setting parameters.

For more information, including upcoming application notes, visit 
www.thermoscientific.com.

http://www.thermoscientific.com
http://www.thermoscientific.com
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Contacting Us
There are several ways to contact Thermo Fisher Scientific. 

Assistance

For technical support and ordering information, visit us on the Web:

www.gc-gcms-customersupport.com/WebPage/Share/Default.aspx

Service contact details are available under:

www.unitylabservice.com

For brochures, application notes and other material, please visit:

www.thermoscientific.com

For operating manuals, please contact your local Service organization.

Changes to the Manual

❖ To suggest changes to this manual

• Please send your comments to:

Technical Documentation
Thermo Fisher Scientific 
2215 Grand Avenue Parkway

Austin, Texas 78728

United States

• Send an e-mail message to the Technical Publications Editor at 
techpubs-austin@thermofisher.com.

You are encouraged to report errors or omissions in the text or index.
Thank you.

http://gc-gcms-customersupport.com/WebPage/Share/Default.aspx
http://www.thermoscientific.com/ms
http://www.unitylabservice.com/
http://www.thermoscientific.com
mailto:techpubs-austin@thermofisher.com
mailto:techpubs-austin@thermofisher.com
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Typographical Conventions
This section describes typographical conventions that have been 
established for Thermo Fisher Scientific manuals.

Signal Word

Make sure you follow the precautionary statements presented in this 
manual. The special notices appear different from the main flow of text:

NOTICE Points out possible material damage and other important 
information in connection with the instrument. ▲

Data Input

Throughout this manual, the following conventions indicate data input 
and output via the computer: 

• Messages displayed on the screen are represented by capitalizing the 
initial letter of each word and by italicizing each word.

• Input that you enter by keyboard is identified by quotation marks: 
single quotes for single characters, double quotes for strings.

• For brevity, expressions such as “choose File > Directories” are used 
rather than “pull down the File menu and choose Directories.”

• Any command enclosed in angle brackets < > represents a single 
keystroke. For example, “press <F1>” means press the key labeled 
F1.

• Any command that requires pressing two or more keys 
simultaneously is shown with a plus sign connecting the keys. For 
example, “press <Shift> + <F1>” means press and hold the <Shift> 
key and then press the <F1> key.

• Any button that you click on the screen is represented in bold face 
letters. For example, “click Close”.
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Topic Headings

The following headings are used to show the organization of topics 
within a chapter:

Chapter 1 Chapter Name

Second Level Topics

Third Level Topics

Fourth Level Topics
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Chapter 1 Instrument Configuration Window

NOTICE Never change the settings in this window except during 
installation of the instrument. Any changes in this window affect the 
data acquisition or the functionality of your instrument. A later change 
will rarely solve problems users have to face. ▲

The Instrument Configuration window displays Q Exactive GC 
configuration information. See Figure 1-1.

Figure 1-1. Instrument Configuration window
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The Instrument Configuration window has the following parameters:

❖ To display this window

1. Choose Programs > Thermo Foundation 3.1 > Instrument 
Configuration.

Parameter Description

Path to instrument files Displays the location of the instrument files.

To change the path, click the folder button on the right side of the text box. A 
dialog box appears where you can select another location.

Path to log files Displays the location of the log files. For information about the content of the log 
files, see “Log Files” on page 6-2.

To change the path, click the folder button on the right side of the text box. A 
dialog box appears where you can select another location

Base port Displays the first TCP/UDP port in use for this particular instrument. Leave the 
field empty for an automatic assignment.

Network address Displays the hardware address of the network card installed in the instrument. 
Leave the field empty for an automatic assignment.

IP address Displays the IP address. Leave the field empty for an automatic assignment.

Public Name Displays the name that is shown in the About dialog box of Q Exactive GC Tune.

Max. audit record length Use this list box to select the maximum audit record length. The following options 
are available:
• 0 disables auditing
• 50 is common for an Access audit database initialized by Platform’s Database 

Configuration
• 255 is common for an Oracle audit database initialized by Platform’s Database 

Configuration
• 1000 is common if auditing is done by Chromeleon. It is a compromise 

between size and readability

Instrument type Displays the configured instrument type, that is Q Exactive GC.

IP address range Displays the IP address or IP address range which should be assigned to the 
instrument during its starting phase. Use the numeric form, for example 
“172.16.2.1-172.16.2.15”.

NOTICE Change only when advised by your network administrator. ▲

Message box Displays information about the instrument and connection status.
Buttons

Apply Saves your changes in this window.

Reset changes Discards your changes in this window.

Help Displays the Help for this window.
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2. From the Instrument Configuration window, click Q Exactive GC - 
Orbitrap MS in the Configured Devices area.

3. Click Configure.
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Chapter 2 Q Exactive GC Readback Status Page for the 
Information View

The readback status of each Xcalibur-configured instrument appears on 
the Status page of the Information view. When you click an instrument, 
Xcalibur™ displays current readings for the instrument on a page below 
the Run Manager pane. See Figure 2-1.

Right-click any of the instruments to display a shortcut menu where you 
can switch your instrument to On, Off, or Standby mode.

NOTICE This view is normally displayed on the left side of the Home 
Page window. If this view is not displayed, the view has been turned 
off. ▲

Figure 2-1. Q Exactive GC Readback Status Page for the Information View
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The following functions are available:

❖ To open this page

1. From the Home Page window, choose View > Info View to display 
the Information view. 

2. Click the Status tab.

3. Click Q Exactive GC - Orbitrap MS.

Button Description

Communication Status Shows the actual communication status of the system:
• Green: communication with instrument is ok.
• Yellow: only service is accessible (no instrument).
• Red: communication is broken (no instrument, no service).

Instrument Status Shows the actual hardware status of the system (top instrument tree 
state):

• Green: all readbacks are in specifications (green hooks).
• Red: one or more readbacks are out of range.

Performance Status Shows the actual performance status of the system:
• Green: the last evaluation/calibration was successful.
• Yellow: last evaluation/calibration was successful, but is out of 

date.
• Red: the evaluation/calibration was not successful.

Tune Opens the Q Exactive GC Tune window.
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Chapter 3 Instrument Setup

After you have selected in the Instrument Configuration program which 
instruments you want Xcalibur to control, use Instrument Setup to 
specify your instrument settings.

Contents

• Instrument Setup Window

• Experiment Setup Page

• Summary Page

• Dialog Boxes of the Experiment Setup Page
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Instrument Setup Window
The Instrument Setup window displays the icons of the instruments 
that you have selected using the Instrument Configuration window. (See 
the View bar on the left side of the window.) See Figure 3-1. If you have 
configured more instruments than can be displayed on your screen, a 
vertical scroll bar appears in the View bar. So, you can access all of the 
instruments.

To enter the setup parameters for a particular instrument, click the icon 
for that instrument. Xcalibur displays one or more pages of parameters 
to be set for the one you selected.

NOTICE Before using the Instrument Setup window, use the 
Instrument Configuration program to select the instruments to be used 
for your experiment. ▲

Use Instrument Setup to specify settings for your instruments after you 
have selected with the Instrument Configuration program the 
instruments that you want Xcalibur to control. The Instrument Setup 
window displays the setup parameters required for each instrument that 
you select on the View bar. These might include your autosampler, GC, 
mass spectrometer, and/or all other Xcalibur supported instruments that 
you have configured.

Figure 3-1. Instrument Setup window
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You can create new methods, modify existing methods, and save method 
files.

❖ To display this window

• Click  from the Roadmap view of the Home Page window.

• Alternatively, choose GoTo > Instrument Setup.

View Bar

The View bar is a vertical bar on the left of the Instrument Setup 
window. It contains buttons for each of the instruments that you have 
selected by using the Instrument Configuration program.

Menus

Instrument Setup contains the following menus:

• File Menu for the Instrument Setup Window

• Help Menu for the Instrument Setup Window

Toolbar

Instrument Setup Window Toolbar

File Menu for the Instrument Setup Window

The File menu provides commands for file and program operations. It 
has the following commands:

Command Description 

New Create a new method file having the appropriate extension.

Open Find and open a file that already exists.

Save Save the active method. Changes will be recorded in Audit Trail after the 
method is saved.

Save As Edit user and description information, and view header information 
about the active file.

Xcalibur opens the Save As dialog box. Changes will be recorded in Audit 
Trail after the method is saved.
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Help Menu for the Instrument Setup Window

The Help menu lists the following commands:

Summary Information Edit user and description information, and view header information 
about the active file.

Change Study Name Select a dataset from a predefined list of names.

The text of this menu item might be different if the administrator chose 
to use another name for a dataset. For example, this menu item might be 
Change Job Name.

Audit Trail View all auditable events and changes made to data files in the current 
application.

Print Print the parameters in your instrument method.

Print Preview View your page setup so that you can see what it looks like before 
printing it.

Print Setup Select the following printing options: printer, form, orientation, and 
one-sided or two-sided printing.

Most Recently Used Files View the paths and names of the last four files used. These are located 
above the Exit command. Both open and closed files are displayed. Click 
a displayed file to load it. If the selected file was closed, it will be opened.

Exit Close the active window. If you exit before clicking OK from an active 
dialog box, Xcalibur asks if you want to save your changes.

Command Description 

Command Description 

Q Exactive GC - Orbitrap 
MS Help

Open the Configuration and Setup Help 
for the instrument.

Instrument Setup Help Open Xcalibur Help and display Help for 
the Instrument Setup window.

Help On Current Item View Help for the Instrument Setup page 
that is currently displayed.

Q Exactive GC - Orbitrap 
MS Contents and Index

View the Contents, Index, and Find Help 
pages for the selected instrument.

Xcalibur Help Open Xcalibur Help.

How to use Online Help Open Help that describes how to use the 
Help viewer.

About Instrument Setup View the version number of the 
Instrument Setup program and the 
Thermo Fisher Scientific copyright 
notice.
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Instrument Setup Window Toolbar

The toolbar provides symbol shortcuts for frequently used commands. 
The following functions are available:

Button Description 

New Create a new instrument method. 

Open Find and open an existing file. 

Save If your method has not been saved before, 
clicking Save opens the Save As dialog box. Select 
the name and location for your instrument 
method. When you click Save, the File Summary 
Information Dialog Box opens. Enter header 
information for your instrument method. The file 
is saved when you click OK.

Print Print the parameters in your instrument method. 

Home Page View the Home Page window—Roadmap view.

Help View Help for the Instrument Setup page that is 
currently displayed.
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Method Editor

Use the Method Editor to specify the type of mass spectrometer 
experiment you plan to perform. See Figure 3-2.

The Method Editor comprises the following pages:

• Experiment Setup Page

• Summary Page

❖ To display this view

Click Instrument Setup from the Roadmap View of the Home 
Page window or choose GoTo > Instrument Setup.

Figure 3-2. Method Editor (Xcalibur)
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Experiment Setup Page
Use the Experiment Setup page to set up Q Exactive GC mass 
spectrometer experiments. You use this page to specify values for the 
Q Exactive GC parameters and save the parameters in an instrument 
method. See Figure 3-3.

The Experiment Setup page comprises four major windows:

• Global Settings Pane

• Experiments Pane

• Graph Pane

• Properties Pane

Figure 3-3. Method Editor—Experiment Setup page

Global Settings pane

Experiments 
pane

Properties 
paneGraph pane
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Global Settings Pane

The Global Settings pane is located on the top left side of the 
Experiment Setup page. It gives access to global lists, tune files, external 
hardware, chromatogram, and scan groups. See Figure 3-4.

The Global Settings pane contains the following panes:

• Global Lists

• Tune Files

• Right-click in the pane to display the shortcut menu. Choose 
Unzoom.Scan Groups

Click the title bar of an individual pane to display it. Click again to hide 
it.

Global Lists

Use the Global Lists pane of the Experiment Setup page to perform 
intelligent automated MS/MS and SIM type experiments by efficiently 
utilizing the mass spectrometer to characterize parent ions independent 
of the “current segment” model. Use the Global Lists pane to specify 
parent, reject, and/or non-data dependent MS/MS and SIM masses 
with customizable and independent time windows. See Figure 3-5. Scan 
events that reference the mass lists that you create here run only if there 
is a corresponding mass/time window at that particular retention time.

The following dialog boxes are available:

• Lock Masses Dialog Box

• Inclusion List Dialog Box

• Exclusion List Dialog Box

Figure 3-4. Method Editor—Global Settings pane

Figure 3-5. Method Editor—Global Lists pane
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• Tag Masses Dialog Box

To display a dialog box, click the respective icon.

Tune Files

The Tune Files pane shows a graphical representation of the tune files 
usage during the various phases of the experiment. See Figure 3-6. In 
addition to the base tune file, you can specify up to 50 other tune files.

❖ To assign tune files

1. Do one of the following:

• Point to a position on the time bar and right-click. Choose 
Change to another tunefile at <time at pointer position> in 
the shortcut menu.

• Change the value of the Switch Count parameter in the 
Properties of Tunefiles pane.

2. In the Properties of Tunefiles pane, click the button next to the 
respective box of the Base Tunefile or New Tunefile parameter and 
browse for the new tune method file. See Figure 3-7. Select the tune 
files and assign them to the experiment phases.

The name and path way of the tune files will be shown on the 
respective time bar on the Tune Files pane.

❖ To change the starting time for tune files

• Position the cursor between adjacent tune files and drag the scan 
event along the time bar.

• In the Properties of Tunefiles pane, enter the time in the box of the 
At parameter of the respective Element.

Figure 3-6. Method Editor—Tune Files

Figure 3-7. Properties of Tunefiles
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❖ To remove a tune file

1. Position the cursor between adjacent tune files

2. Right-click to display the shortcut menu and choose Remove 
change to tunefile at <time at pointer position>. The tune file to 
the right is removed.

❖ To zoom on the Tune Files pane

• Position the mouse pointer within the time axis area and drag the 
mouse across the time area of interest.

• To zoom in, position the mouse pointer within the pane and roll the 
mouse wheel forward.

• To zoom out, roll the wheel backward.

• To increase the zooming factor by two, keep the <Shift> key pressed 
while using the mouse wheel.

❖ To unzoom the Tune Files pane

Right-click in the pane to display the shortcut menu. Choose Unzoom.Scan Groups

In the Scan Groups pane, time bars represent the scan events during the 
acquisition. See Figure 3-8. The Scan Groups pane is filled when you 
drag experiment symbols from the experiments pane to the Graph pane.

Use the Properties pane of a scan event to control the activities during 
individual experiments. Red triangles ( ) to the left side of a time bar 
indicate active scan events.

❖ To display the active scan events at a certain time

Click the time line at the position. A red arrow ( ) indicates the 
selected time. A green triangle ( ) to the left side of the time bar 
indicates the active scan event. If scan events overlap at the selected 
time, green triangles appear for each active scan event. The bottom 
part of the Properties pane shows the parameters for the selected 
scan event.

Figure 3-8. Scan Groups
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❖ To change start and end time of a scan event

• Drag the left and right edges of the time bar to the desired positions 
on the time line.

• Enter the times in the Minimum and Maximum boxes of the 
runtime parameter on the Properties pane.

❖ To zoom on the Scan Groups pane

• Position the mouse pointer within the time axis area and drag the 
mouse across the time area of interest.

• To zoom in, position the mouse pointer within the pane and roll the 
mouse wheel forward.

• To zoom out, roll the wheel backward.

• To increase the zooming factor by two, keep the <Shift> key pressed 
while using the mouse wheel.

❖ To unzoom the Scan Groups pane

Right-click in the pane to display the shortcut menu. Choose 
Unzoom.

Experiments Pane

The Experiments pane is located on the bottom left side of the 
Experiment Setup page. It gives access to predefined experiment 
templates. You cannot delete the experiment templates.

Every single experiment is associated with a descriptive icon. This icon 
can be dragged from the Experiments pane to the Graph pane. When 
selected, the icon gives an overview to the operator, which experiment 
and which associated options are active currently. Therefore, this icon 
changes dependent on the settings. Use the Properties pane to specify 
the values for your experiment parameters.
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General Experiment Templates

The General folder contains predefined templates for experiments. See 
Figure 3-9.

In Xcalibur, the Experiment Setup page allows using several system 
templates in an instrument method.

Experiment Symbols

The following experiment templates are available on the experiments 
pane:

Figure 3-9. Available general templates

Template Experiment Symbol Description

General Experiment Templates

Full MS – SIM This experiment comprises a full MS scan or SIM scan 
without HCD fragmentation.

Special features:
• Segmented Master Scans

Full MS / dd-MS2 (TopN) This experiment comprises a full MS scan (without 
collision energy) followed by a set of Data Dependent™ 
scans with a fragmentation energy applied. Ions of the 
second scan event enter the HCD collision cell, ions of the 
first do not.

Special features:
• Auto value option: Dynamic Exclusion
• Segmented Master Scans
• Spectral Multiplexing (MSX)
• Stepped Collision Energy



Instrument Setup
Experiment Setup Page

Thermo Scientific Q Exactive GC Software Manual (P/N 1R120706-0003, Revision B) 3-13

Graph Pane

The Graph pane is located at the middle bottom side of the Experiment 
Setup window. It shows a graphic representation of the experiment 
during the acquisition. See Figure 3-10.

Targeted-SIM This experiment acquires SIM scans depending on the 
entries of the inclusion list, which is therefore mandatory 
and always activated.

Special features:
• Spectral Multiplexing (MSX)

PRM This Parallel Reaction Monitoring (PRM) experiment 
comprises MS/MS scans depending on the entries of the 
inclusion list. The mandatory inclusion list will be 
processed from first to last row without any automated 
sorting.

Special features:
• Spectral Multiplexing (MSX)
• Stepped Collision Energy

Targeted-SIM / dd-MS2 This experiment comprises a targeted-SIM scan on 
precursor ions followed by a set of Data Dependent 
triggered MS/MS scans.

Special features:
• Auto value option: Dynamic Exclusion
• Spectral Multiplexing (MSX)
• Stepped Collision Energy

Template Experiment Symbol Description

Figure 3-10. Graphic representation of the experiment
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❖ To add an experiment to the active method

1. Drag an experiment symbol from the experiments pane to the gray 
bar in the Graph pane.

In Xcalibur, the Scan Groups pane shows a corresponding time bar 
for each symbol.

2. Use the Properties pane of a experiment to control the activities 
during individual experiments.

❖ To delete an experiment

1. Right-click the experiment symbol to display the shortcut menu.

2. Choose Delete this <Name of experiment>.

❖ To zoom in or out on the Graph pane

• Position the mouse pointer within the pane and roll the mouse 
wheel forward to zoom in.

• Roll the wheel backward to zoom out.

The zoom factor ranges from 0.25 to 2. The actual zoom factor is 
displayed in the top right corner of the Graph pane.
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Properties Pane

The Properties pane is located at the right side of the Experiment Setup 
page. See Figure 3-11.

The pane consists of two parts:

• Properties of the Method

The upper part is always available. It shows the properties of the 
active method.

NOTICE Some properties are only available in Advanced user mode.

The lower part depends on the item that is selected on the left side 
of the Experiment Setup page. One of the following tables is 
displayed:

In Xcalibur:

- Properties of Full MS – SIM

- Properties of Full MS / dd-MS2 (TopN)

- Properties of Targeted-SIM

- Properties of PRM

- Properties of Targeted-SIM / dd-MS2

Figure 3-11. Properties pane
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Properties of the Method

The properties of the method include the following parameters:

Parameter Description

Global Settings

User Role Use this field to specify whether the advanced parameters for scan events are 
displayed or not. To show the advanced parameters, set the field to 
Advanced. To hide the advanced parameters, set the field to Standard. 
Double-click into the field to change the status.

Use lock masses Use the list box to specify how lock masses are used in the active instrument 
method. The following options are available:
• off

No lock masses are used.
• best

Only the most intense lock mass of the global list that is found in the 
spectrum is used for a calibration.

• if all present
Lock masses are used only when all active masses of the global lock mass 
list are present at the same time.

NOTICE If timed lock masses are used, the Q Exactive GC mass 
spectrometer takes into account only those lock masses whose time windows 
cover the current retention time. ▲

Lock mass injection If lock masses are used in the active instrument method, use this field to 
select the scan types for which lock mass will be additionally injected. The 
mass spectrometer will inject all lock masses of the active lock mass list to 
provide additional signals to improve mass accuracy. The decision whether 
found lock masses will be used for the mass correction is not affected and 
depends on the settings for the “use lock masses” parameter.

Enter the scan types manually by using commas as separators for the strings. 
Alternatively, click the down arrow to display a dialog box and select the 
corresponding check boxes. The following options are available:
• Full MS
• MS2

• SIM
Time

Method duration Use this box to specify the total mass spectrometer acquire time, in minutes, 
for the run. Q Exactive GC Tune rescales the Segments bar to correspond to 
the specified acquire time.

To change the time, click the arrows in the spin box to increment [up arrow] 
or decrement [down arrow] the value. Alternatively, you can enter the time in 
the spin box text field. The valid range for the time is from 0.1 to 
10000 minutes.

Customized Tolerances (+/-)
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Lock Masses
Inclusion
Exclusion
Mass Tags
Dynamic Exclusion

Use the boxes in this group to adjust mass tolerances for global lists in 
different instrument methods. The tolerance can be set independently for 
each list type.

To change a tolerance, click the arrows in the spin box to increment [up 
arrow] or decrement [down arrow] the value. Alternatively, you can enter the 
tolerance in the spin box text field. Available options are:
• – (use instrument default)
• 0.1–1000 ppm
• 0.1–50000 amu

When you directly enter a tolerance in the text field, you can use additional 
units. The software will convert it to ppm or amu depending of its nature 
(absolute or relative definition). Accepted units are (for absolute definition: 
Da, Th, u, amu; for a relative definition: ppt, ppb, ppm, %). An empty 
property value field as well as a set value of 0, -, or off will result in using the 
instrument default (displayed as –). 

Parameter Description
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EI/CI Source

Filament on Delay
MS Transfer Line Temp
Ion Source Temp
Ionization Mode
CI Gas Type
CI Gas Flow
Use Tune Emission Current
Emission Current
Use Tune Electron Energy
Cal Gas Level

Use the boxes in this group to adjust the EI or CI ion source settings for 
global lists in different instrument methods. 
• Filament on Delay: Set the initial time delay to account for the solvent 

front. The delay will begin after the run starts (contact closure) before 
turning on the filament.

• MS Transfer Line Temp: Set the temperature for the part of the transfer 
line that is inside the vacuum manifold. Temperatures from 
200 – 280 °C are recommend for most applications.

• Ion Source Temp: This allows the user to set the ion source temperature. 
Temperatures from 200 – 350 °C are recommend for most applications.

• Ionization Mode: Set to EI or CI ionization mode depending on analysis. 
The mode must be set to CI to turn on CI gas.

NOTICE The CI or EI/CI ion volume must be installed in the ion source 
cartridge to use CI ionization mode. ▲

• CI Gas Type: Select the type of CI gas to use for the analysis. Selection 
options are methane, isobutane, ammonia, carbon dioxide, or other. 
Configure the selected gas on Port A or Port B within Tune.

• CI Gas Flow: Set the CI gas flow rate.
• Use Tune Emission Current: Select True to set the filament emission 

current to the value saved in the tune file during the acquisition. Select 
False to set the emission current in the method and override the value in 
the tune file.

• Emission Current (Only visible if “Use Tune Emission Current” is set to 
“False”): Set the emission current to be used during acquisition instead of 
the emission current in the tune file.

• Use Tune Electron Energy: Select True to set the filament voltage to the 
value saved in the tune file during the acquisition. Select False to set the 
filament voltage in the method and override the value in the tune file 
during acquisition. When setting low electron energies, the electron lens 
may also need to be set to a new value in the tune file.

• Cal Gas Level: Set the calibration gas to the EI or the higher CI level 
during acquisition.

Parameter Description
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NOTICE In some cases the instrument will not allow the filament to be 
turned on to protect against damage. This can happen when the 
electron energy is set low and the read value for the filament voltage has 
not returned a negative voltage, or the electron lens is not at least 45 V 
more positive than the filament. In these cases, make sure the filament 
and electron lens are at the appropriate values in Tune before starting an 
acquisition. Also notice that in some cases, when the electron energy is 
set low, the instrument must override the user value in the tune file for 
the electron lens in order to meet the required conditions to protect the 
filament. The filament voltage is calculated by the instrument from the 
ion source offset and the electron energy settings. ▲

Properties of Full MS – SIM

The properties of a Full MS – SIM experiment include the following 
parameters:

Parameter Description

General

Runtime Use this box to specify the duration in minutes of the active scan event. Click into 
the field to display the spin boxes for the start time (Minimum) and the end time 
(Maximum) of the scan event.

To change a value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Alternatively, you can enter a value in the spin 
box text field. The valid range for the start time is from 0 to (end time minus 
0.01) minutes. The valid range for the end time is from (start time plus 0.01) to 
10000 minutes.

Alternatively, drag the left and right edges of the corresponding time bar to the 
desired positions on the time line in the Scan Groups pane.

Polarity Use this list box to toggle between positive ion and negative ion polarity.
Full MS – SIM

Use the parameters in this group to specify the properties of the master scan(s).

Microscans Use this spin box to select the number of microscans to be performed. To change 
the value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value. Alternatively, you can enter a value in the spin box text 
field. The valid range is from 1 to 10 microscans.

Resolution Use this list box to select the mass resolution used during the selected scan event. 
The mass resolution of the Orbitrap analyzer is proportional to 1/sqrt (m/z). The 
scan time increases with increasing resolution and detect time. Available options 
are 15000, 30000, 60000, or 120000. Resolution is calculated according to the 
IUPAC peak width definition. The available settings represent m/∆m or the m/z 
value of an ion at m/z 200 divided by the full width at half its maximum height 
(FWHM).
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❖ To show this view

Click the Full MS symbol in the Graph pane.

AGC target Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Maximum IT Use this list box to type or click a maximum allowed injection time to reach the 
AGC target value. For example, type 160. The valid range is from 1 to 
3000 milliseconds.

Number of scan ranges Use this spin box to enter the number of segments in a segmented master scan. 
The segments can be defined independently from each other. They can be used to 
get a better S/N for specific areas and exclude matrix signals. The m/z ranges are 
acquired one after another and will result one scan for each range.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. The valid range is from 1 to 8 scans.

Scan range n (n=1–8) Use the spin boxes in this field to set values for Minimum, Maximum, Center, 
and Width for the current scan range. To change the value, click the arrows in the 
spin box to increment [up arrow] or decrement [down arrow] the value.
• Minimum

Select the minimum value for the scan range (in mass-to-charge ratio units). 
You can enter any value from 30.0 to 2500.0.

NOTICE Scanning below 50 m/z might reduce instrument performance. ▲

• Maximum
Select the maximum value for the scan range (in mass-to-charge ratio units). 
You can enter any value from 30.4 to 3000.0.

• Center
Select the center mass (in mass-to-charge ratio units) of the scan range. You 
can enter any value from 30.2 to 2750.0.

• Width
Select the width of the scan range (in mass-to-charge ratio units). You can 
enter any value from 0.4 to 2800.0.

Spectrum data type Use this list box to toggle between Profile data format and Centroid data format.

Parameter Description
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Properties of Full MS / dd-MS2 (TopN)

The properties of a Full MS / dd-MS2 experiment include the following 
parameters:

Parameter Description

General

Runtime Use this box to specify the duration in minutes of the active scan event. Click into 
the field to display the spin boxes for the start time (minimum) and the end time 
(maximum) of the scan event.

To change a value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Alternatively, you can enter a value in the spin 
box text field. The valid range for the start time is from 0 to (end time minus 
0.01) minutes. The valid range for the end time is from (start time plus 0.01) to 
10000 minutes.

Alternatively, drag the left and right edges of the corresponding time bar to the 
desired positions on the time line in the Scan Groups pane.

Polarity Use this list box to toggle between positive ion and negative ion polarity.

Inclusion Use this field to enable the inclusion masses list that is attached to the active 
instrument method. Available options are on (inclusion list enabled) and – 
(inclusion list disabled). Default setting is –.

Exclusion Use this field to enable the exclusion masses list that is attached to the active 
instrument method. Available options are on (exclusion list enabled) and – 
(exclusion list disabled). Default setting is –.

Tags Use this field to enable the tag masses list for the active instrument method. 
Available options are on (list enabled) and – (list disabled). Default setting is –.

Full MS

Microscans Use this spin box to enter the number of microscans to be performed. To change 
the value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value. Alternatively, you can enter a value in the spin box text 
field. The valid range is from 1 to 10 microscans.

Resolution Use this list box to select the mass resolution used during the selected scan event. 
The mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The 
scan time increases with increasing resolution and detect time. Available options 
are 15000, 30000, 60000, or 120000. Resolution is calculated according to the 
IUPAC peak width definition. The available settings represent m/∆m or the m/z 
value of an ion at m/z 200 divided by the full width at half its maximum height 
(FWHM).

AGC target Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.
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Maximum IT Use this list box to type or click a maximum allowed injection time to reach the 
AGC target value. For example, type 160. The valid range is from 1 to 
3000 milliseconds.

Number of scan ranges Use this spin box to enter the number of segmented master scans. Segmented 
master scans can be defined independently from each other. They can be used to 
get a better S/N for specific areas and exclude matrix signals. The scan ranges are 
acquired one after another and will result one scan for each range.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. The valid range is from 1 to 8 scan ranges.

Scan range n (n=1–8) Use the spin boxes in this field to enter values for Minimum, Maximum, Center, 
and Width for the current scan range. To change the value, click the arrows in the 
spin box to increment [up arrow] or decrement [down arrow] the value.
• Minimum

Select the minimum value for the scan range (in mass-to-charge ratio units). 
You can enter any value from 30.0 to 2500.0.

NOTICE Scanning below 50 m/z might reduce instrument performance. ▲

• Maximum
Select the maximum value for the scan range (in mass-to-charge ratio units). 
You can enter any value from 30.4 to 3000.0.

• Center
Select the center mass (in mass-to-charge ratio units) of the scan range. You 
can enter any value from 30.2 to 2750.0.

• Width
Select the width of the scan range (in mass-to-charge ratio units). You can 
enter any value from 0.4 to 2800.0.

Spectrum data type Use this list box to toggle between Profile data format and Centroid data format.
dd-MS2 / dd-SIM

Microscans Use this spin box to enter the number of microscans to be performed. To change 
the value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value. Alternatively, you can enter a value in the spin box text 
field. The valid range is from 1 to 10 microscans.

Resolution Use this list box to select the mass resolution used during the selected scan event. 
The mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The 
scan time increases with increasing resolution and detect time. Available options 
are 15000, 30000, 60000, or 120000. Resolution is calculated according to the 
IUPAC peak width definition. The available settings represent m/∆m or the m/z 
value of an ion at m/z 200 divided by the full width at half its maximum height 
(FWHM).

AGC target Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Parameter Description
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Maximum IT Use this list box to type or click a maximum allowed injection time to reach the 
AGC target value. For example, type 160. The valid range is from 1 to 
3000 milliseconds.

Loop count Use this spin box to enter the number of repetitions of the corresponding scan 
event before continuing with the next scan event or experiment cycle.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Alternatively, you can enter a value in the spin 
box text field. The valid range is from 1 (no repetition) to 100 repetitions.

MSX count Use this spin box to enter the maximum number of precursors to be multiplexed 
in an scan event. In spectra multiplexing, multiple preselected precursors are 
collected in the C-Trap for simultaneous detection in the Orbitrap analyzer.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Alternatively, you can enter a value in the spin 
box text field. The valid range is from 1 (no spectral multiplexing) to 10 fillings.

TopN This field displays the product of the selected values for Loop count and 
MSX count as maximum number of the most abundant precursors that will be 
selected.

Isolation window Use this list box to enter the isolation width (in mass-to-charge ratio units) for the 
parent ion of interest. The mass range for the peak is centered at the parent mass 
and ranges one-half of the isolation width to either side of the parent mass. You 
can set the isolation window to any value from m/z 0.4 to 50 times the first mass 
of the Data Dependent scan. The default value is m/z 4.0.

Too low a value results in loss of sensitivity because not all of the ions in a mass 
peak or in neighboring isotopic peaks are isolated. Too high a value causes 
interference from neighboring peaks.

Isolation offset Use this spin box to define an absolute offset by which the isolation window is 
shifted. The resulting window is non-symmetric with regard to the precursor m/z. 
Thus, more isotopes of a cluster might be covered, without the need of expanding 
the isolation window.

Example:
Precursor = m/z 524.265; Isolation window = 2.0 m/z; Isolation offset = +0.5 m/z;
Resulting isolation window = m/z 523.765–525.765

To change the isolation offset, click the arrows in the spin box to increment [up 
arrow] or decrement [down arrow] the value. You can set the isolation offset to 
any value from m/z -50 to +50. Default is m/z 0.

Parameter Description
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Fixed first mass Use this box to specify whether to use a first mass of the Data Dependent scan. 
After an automated determination of the detection mass range, the first mass will 
be set to the defined fixed first mass. Because only masses up to 15 times the first 
mass can be trapped in the C-Trap, loss of ions in the upper detection range may 
occur. 

To change the Fixed first mass, click the arrows in the spin box to increment [up 
arrow] or decrement [down arrow] the value. You can set Fixed first mass either to 
– (no Fixed first mass) or to any value from m/z 30 to 750. Default is –.

CE / Stepped CE Use this box to specify the collision energy (CE). This dimensionless number is 
approximately equivalent to the HCD collision energy (in eV) for a reference ion 
of mass 500 and charge 1. The actual HCD energy is calculated on basis of mass 
and charge of the selected precursor ion. 

If more than one CE value is entered, the Q Exactive GC mass spectrometer will 
perform a stepwise fragmentation on the precursor ion. All fragments created in 
the steps are collected and sent to the Orbitrap analyzer for one scan detection.

Enter up to three CE values manually separated by blanks or the locally defined 
“list separator” (defined for Microsoft™ Windows™ via the “Region and 
Language” settings).

Alternatively, click the down arrow to display a dialog box and select the 
corresponding number of check boxes. To change an CE value, click the arrows in 
the spin box to increment [up arrow] or decrement [down arrow] the value. You 
can set CE to any value from 10 to 200. Default is 30.

Spectrum data type Use this list box to toggle between Profile data format and Centroid data format.
dd Settings

Use the parameters in this group to specify criteria for selecting one or more ions of interest on which to 
perform subsequent scans.

Underfill ratio Use this box to specify a minimum percentage of the AGC Target value. If the 
mass peak of interest reaches this intensity within the maximum IT, the 
Q Exactive GC mass spectrometer initiates a Data Dependent scan. The valid 
range is from 0 to 100%.

Example: AGC Target = 1e5, maximum IT = 250 ms, underfill ratio = 1%: 
trigger threshold is 1000 charges in 250 ms.

Intensity threshold This field displays the minimum intensity that a mass peak requires to initiate a 
Data Dependent scan.

Parameter Description
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Apex trigger To obtain the highest quality data in the shortest period of time, it is best to defer 
data acquisition until near the apex of a chromatographic peak. Using the 
chromatographic peak apex detection provides numerous benefits for Data 
Dependent GC/MS/MS, including:
• Improved MS/MS quality and signal levels
• Shorter ion injection times
• Reduced MS/MS acquisition of chemical background
• Less dependence on static or dynamic exclusion lists
• Reduced retriggering of scans on tailing chromatographic peaks

Use this box to enter start (Minimum) and end (Maximum) of a retention time 
window in seconds relative to the occurrence of a precursor. If the Q Exactive GC 
mass spectrometer finds an apex within the window, it triggers a Data Dependent 
acquisition for the corresponding m/z or range of m/z. The mass spectrometer also 
triggers a Data Dependent scan when the end of the time window is reached 
without detecting an apex. The apex trigger always depends on other selection 
criteria (for example, intensity threshold).
• Minimum

Enter the minimum value for the time window (in seconds). You can enter 
any value from – (0) to 360. The default value is –.

• Maximum
Enter the maximum value for the time window (in seconds). You can enter 
any value from – (0) to 360. The default value is –.

Exclude isotopes Use this field to define a window around a reference Data Dependent mass 
(including dynamic exclusion list masses) inside which other peaks in the window 
will not trigger a subsequent data-dependent scan. Use this feature, for example, 
to exclude isotope clusters.

Available options are on (isotopes exclusion enabled) and – (isotopes exclusion 
disabled). Default setting is on.

Parameter Description
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❖ To show this view

Click the Full MS / dd-MS2 symbol in the Graph pane.

Properties of Targeted-SIM

The properties of a Targeted-SIM experiment include the following 
parameters:

Dynamic exclusion Use this box to enter a time (in seconds) to prevent an ion from triggering a 
subsequent Data Dependent scan after it has already triggered a Data Dependent 
scan. 

The following inputs are possible:
• – (no dynamic exclusion)
• 0.1 to 50000

Dynamic exclusion is valuable if the Q Exactive GC mass spectrometer has 
obtained enough data on an ion or if the base peak corresponds to a contaminant 
or an ion of non interest. If you enable dynamic exclusion, and if the mass 
spectrometer performs a Data Dependent scan on an ion, that ion is placed on the 
exclusion list (a temporary reject mass list) for a user-specified period of time. 
Then, when the mass spectrometer performs another Data Dependent scan on 
another ion, that ion is also placed on the exclusion list, and so on.

if idle Use this field to select the behavior of the Q Exactive GC mass spectrometer 
when it has finished the Data Dependent scans that were triggered by a mass that 
meets the established criteria for Data Dependent actions. Available options are 
do not pick others and pick other. Default setting is do not pick others.

This parameter is available only when at least one of the parameters Inclusion or 
Tags is set to on.

Parameter Description

Parameter Description

General

Runtime Use this box to specify the duration in minutes of the active scan event. Click into the 
field to display the spin boxes for the start time (minimum) and the end time 
(maximum) of the scan event.

To change a value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Alternatively, you can enter a value in the spin box 
text field. The valid range for the start time is from 0 to (end time minus 0.01) 
minutes. The valid range for the end time is from (start time plus 0.01) to 10000 
minutes.

Alternatively, drag the left and right edges of the corresponding time bar to the desired 
positions on the time line in the Scan Groups pane.

Polarity Use this list box to toggle between positive ion and negative ion polarity.
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Inclusion Because this experiment requires inclusion masses, this field is always set to on 
(inclusion list enabled).

SIM

Microscans Use this spin box to enter the number of microscans to be performed. To change the 
value, click the arrows in the spin box to increment [up arrow] or decrement [down 
arrow] the value. Alternatively, you can enter a value in the spin box text field. The 
valid range is from 1 to 10 microscans.

Resolution Use this list box to select the mass resolution used during the selected scan event. The 
mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The scan time 
increases with increasing resolution and detect time. Available options are 15000, 
30000, 60000, or 120000. Resolution is calculated according to the IUPAC peak 
width definition. The available settings represent m/∆m or the m/z value of an ion at 
m/z 200 divided by the full width at half its maximum height (FWHM).

AGC target Use this list box to select the AGC target value for the selected scan event. The AGC 
target value controls the number of ions that are injected into the Orbitrap analyzer. 
Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Maximum IT Use this list box to type or click a maximum allowed injection time to reach the 
AGC target value. For example, type 160. The valid range is from 1 to 
3000 milliseconds.

MSX count Use this spin box to enter the maximum number of precursors to be multiplexed in an 
scan event. In spectra multiplexing, multiple preselected precursors are collected in the 
C-Trap for simultaneous detection in the Orbitrap analyzer.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Alternatively, you can enter a value in the spin box 
text field. The valid range is from 1 (no spectral multiplexing) to 10 fillings.

Isolation window Use this list box to enter the isolation width (in mass-to-charge ratio units) for the 
parent ion of interest. The mass range for the peak is centered at the parent mass and 
ranges one-half of the isolation width to either side of the parent mass. You can set the 
isolation window to any value from m/z 0.4 to 50 times the first mass of the Data 
Dependent scan. The default value is m/z 4.0.

Too low a value results in loss of sensitivity because not all of the ions in a mass peak or 
in neighboring isotopic peaks are isolated. Too high a value causes interference from 
neighboring peaks.

Parameter Description
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❖ To show this view

Click the Targeted-SIM symbol in the Graph pane.

Properties of PRM

The properties of a PRM experiment include the following parameters:

Isolation offset Use this spin box to define an absolute offset by which the isolation window is shifted. 
The resulting window is non-symmetric with regard to the precursor m/z. Thus, more 
isotopes of a cluster might be covered, without the need of expanding the isolation 
window.

Example:
Precursor = m/z 524.265; Isolation window = 2.0 m/z; Isolation offset = +0.5 m/z;
Resulting isolation window = m/z 523.765–525.765

To change the isolation offset, click the arrows in the spin box to increment [up arrow] 
or decrement [down arrow] the value. You can set the isolation offset to any value from 
m/z -50 to +50. Default is m/z 0.

Spectrum data type Use this list box to toggle between Profile data format and Centroid data format.

Parameter Description

Parameter Description

General

Runtime Use this box to specify the duration in minutes of the active scan event. Click into 
the field to display the spin boxes for the start time (minimum) and the end time 
(maximum) of the scan event.

To change a value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Alternatively, you can enter a value in the spin 
box text field. The valid range for the start time is from 0 to (end time minus 0.01) 
minutes. The valid range for the end time is from (start time plus 0.01) to 10000 
minutes.

Alternatively, drag the left and right edges of the corresponding time bar to the 
desired positions on the time line in the Scan Groups pane.

Polarity Use this list box to toggle between positive ion and negative ion polarity.

Inclusion Because this experiment requires inclusion masses, this field is always set to on 
(inclusion list enabled).

MS2

Microscans Use this spin box to enter the number of microscans to be performed. To change the 
value, click the arrows in the spin box to increment [up arrow] or decrement [down 
arrow] the value. Alternatively, you can enter a value in the spin box text field. The 
valid range is from 1 to 10 microscans.
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Resolution Use this list box to select the mass resolution used during the selected scan event. 
The mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The 
scan time increases with increasing resolution and detect time. Available options are 
15000, 30000, 60000, or 120000. Resolution is calculated according to the IUPAC 
peak width definition. The available settings represent m/∆m or the m/z value of an 
ion at m/z 200 divided by the full width at half its maximum height (FWHM).

AGC target Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Maximum IT Use this list box to type or click a maximum allowed injection time to reach the 
AGC target value. For example, type 160. The valid range is from 1 to 
3000 milliseconds.

MSX count Use this spin box to enter the maximum number of precursors to be multiplexed in 
an scan event. In spectra multiplexing, multiple preselected precursors are collected 
in the C-Trap for simultaneous detection in the Orbitrap analyzer.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Alternatively, you can enter a value in the spin 
box text field. The valid range is from 1 (no spectral multiplexing) to 10 fillings.

MSX isochronous ITs This field shows on to indicate that for multiplexing scans, all isolated windows are 
injected into the HCD cell with the same injection time.

Isolation window Use this list box to enter the isolation width (in mass-to-charge ratio units) for the 
parent ion of interest. The mass range for the peak is centered at the parent mass and 
ranges one-half of the isolation width to either side of the parent mass. You can set 
the isolation window to any value from m/z 0.4 to 50 times the first mass of the Data 
Dependent scan. The default value is m/z 4.0.

Too low a value results in loss of sensitivity because not all of the ions in a mass peak 
or in neighboring isotopic peaks are isolated. Too high a value causes interference 
from neighboring peaks.

Isolation offset Use this spin box to define an absolute offset by which the isolation window is 
shifted. The resulting window is non-symmetric with regard to the precursor m/z. 
Thus, more isotopes of a cluster might be covered, without the need of expanding 
the isolation window.

Example:
Precursor = m/z 524.265; Isolation window = 2.0 m/z; Isolation offset = +0.5 m/z;
Resulting isolation window = m/z 523.765–525.765

To change the isolation offset, click the arrows in the spin box to increment [up 
arrow] or decrement [down arrow] the value. You can set the isolation offset to any 
value from m/z -50 to +50. Default is m/z 0.

Parameter Description
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❖ To show this view

Click the PRM symbol in the Graph pane.

Fixed first mass Use this box to specify whether to use a first mass of the Data Dependent scan. After 
an automated determination of the detection mass range, the first mass will be set to 
the defined fixed first mass. Because only masses up to 15 times the first mass can be 
trapped in the C-Trap, loss of ions in the upper detection range may occur. 

To change the Fixed first mass, click the arrows in the spin box to increment [up 
arrow] or decrement [down arrow] the value. You can set Fixed first mass either to 
– (no Fixed first mass) or to any value from m/z 30 to 750. Default is –.

CE / Stepped CE Use this box to specify the collision energy (CE). This dimensionless number is 
approximately equivalent to the HCD collision energy (in eV) for a reference ion of 
mass 500 and charge 1. The actual HCD energy is calculated on basis of mass and 
charge of the selected precursor ion. 

If more than one CE value is entered, the Q Exactive GC mass spectrometer will 
perform a stepwise fragmentation on the precursor ion. All fragments created in the 
steps are collected and sent to the Orbitrap analyzer for one scan detection.

Enter up to three CE values manually separated by blanks or the locally defined “list 
separator” (defined for Microsoft™ Windows™ via the “Region and Language” 
settings).

Alternatively, click the down arrow to display a dialog box and select the 
corresponding number of check boxes. To change an CE value, click the arrows in 
the spin box to increment [up arrow] or decrement [down arrow] the value. You can 
set CE to any value from 10 to 200. Default is 30.

Spectrum data type Use this list box to toggle between Profile data format and Centroid data format.

Parameter Description
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Properties of Targeted-SIM / dd-MS2

The properties of a Targeted-SIM / dd-MS2 experiment include the 
following parameters:

Parameter Description

General

Runtime Use this box to specify the duration in minutes of the active scan event. Click into 
the field to display the spin boxes for the start time (minimum) and the end time 
(maximum) of the scan event.

To change a value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Alternatively, you can enter a value in the spin 
box text field. The valid range for the start time is from 0 to (end time minus 0.01) 
minutes. The valid range for the end time is from (start time plus 0.01) to 
10000 minutes.

Alternatively, drag the left and right edges of the corresponding time bar to the 
desired positions on the time line in the Scan Groups pane.

Polarity Use this list box to toggle between positive ion and negative ion polarity.

Inclusion Because this experiment requires inclusion masses, this field is always set to on 
(inclusion list enabled).

SIM

Microscans Use this spin box to enter the number of microscans to be performed. To change the 
value, click the arrows in the spin box to increment [up arrow] or decrement [down 
arrow] the value. Alternatively, you can enter a value in the spin box text field. The 
valid range is from 1 to 10 microscans.

Resolution Use this list box to select the mass resolution used during the selected scan event. 
The mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The 
scan time increases with increasing resolution and detect time. Available options are 
15000, 30000, 60000, or 120000. Resolution is calculated according to the IUPAC 
peak width definition. The available settings represent m/∆m or the m/z value of an 
ion at m/z 200 divided by the full width at half its maximum height (FWHM).

AGC target Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Maximum IT Use this list box to type or click a maximum allowed injection time to reach the 
AGC target value. For example, type 160. The valid range is from 1 to 
3000 milliseconds.

Loop count Use this spin box to enter the number of repetitions of the corresponding scan event 
before continuing with the next scan event or experiment cycle.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Alternatively, you can enter a value in the spin 
box text field. The valid range is from 1 (no repetition) to 100 repetitions.
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MSX count Use this spin box to enter the maximum number of precursors to be multiplexed in 
an scan event. In spectra multiplexing, multiple preselected precursors are collected 
in the C-Trap for simultaneous detection in the Orbitrap analyzer.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Alternatively, you can enter a value in the spin 
box text field. The valid range is from 1 (no spectral multiplexing) to 10 fillings.

Isolation window Use this spin box to enter the isolation width (in mass-to-charge ratio units) for the 
parent ion of interest. The mass range for the peak is centered at the parent mass and 
ranges one-half of the isolation width to either side of the parent mass. You can set 
the isolation window to any value from m/z 0.4 to 50 times the first mass of the 
Data Dependent scan. The default value is m/z 4.0.

Too low a value results in loss of sensitivity because not all of the ions in a mass peak 
or in neighboring isotopic peaks are isolated. Too high a value causes interference 
from neighboring peaks.

Isolation offset Use this spin box to define an absolute offset by which the isolation window is 
shifted. The resulting window is non-symmetric with regard to the precursor m/z. 
Thus, more isotopes of a cluster might be covered, without the need of expanding 
the isolation window.

Example:
Precursor = m/z 524.265; Isolation window = 2.0 m/z; Isolation offset = +0.5 m/z;
Resulting isolation window = m/z 523.765–525.765

To change the isolation offset, click the arrows in the spin box to increment [up 
arrow] or decrement [down arrow] the value. You can set the isolation offset to any 
value from m/z -50 to +50. Default is m/z 0.

Spectrum data type Use this list box to toggle between Profile data format and Centroid data format.
dd-MS2

Microscans Use this spin box to enter the number of microscans to be performed. To change the 
value, click the arrows in the spin box to increment [up arrow] or decrement [down 
arrow] the value. Alternatively, you can enter a value in the spin box text field. The 
valid range is from 1 to 10 microscans.

Resolution Use this list box to select the mass resolution used during the selected scan event. 
The mass resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The 
scan time increases with increasing resolution and detect time. Available options are 
15000, 30000, 60000, or 120000. Resolution is calculated according to the IUPAC 
peak width definition. The available settings represent m/∆m or the m/z value of an 
ion at m/z 200 divided by the full width at half its maximum height (FWHM).

AGC target Use this list box to select the AGC target value for the selected scan event. The 
AGC target value controls the number of ions that are injected into the Orbitrap 
analyzer. Available options are 2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, or 5e6.

Parameter Description
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Maximum IT Use this list box to type or click a maximum allowed injection time to reach the 
AGC target value. For example, type 160. The valid range is from 1 to 
3000 milliseconds.

Loop count Use this spin box to enter the number of repetitions of the corresponding scan event 
before continuing with the next scan event or experiment cycle.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Alternatively, you can enter a value in the spin 
box text field. The valid range is from 1 (no repetition) to 100 repetitions.

MSX count Use this spin box to enter the maximum number of precursors to be multiplexed in 
an scan event. In spectra multiplexing, multiple preselected precursors are collected 
in the C-Trap for simultaneous detection in the Orbitrap analyzer.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Alternatively, you can enter a value in the spin 
box text field. The valid range is from 1 (no spectral multiplexing) to 10 fillings.

TopN This field displays the product of the selected values for Loop count and MSX count 
as maximum number of the most abundant precursors that will be selected.

Isolation window Use this spin box to enter the isolation width (in mass-to-charge ratio units) for the 
parent ion of interest. The mass range for the peak is centered at the parent mass and 
ranges one-half of the isolation width to either side of the parent mass. You can set 
the isolation window to any value from m/z 0.4 to 50 times the first mass of the 
Data Dependent scan. The default value is m/z 4.0.

Too low a value results in loss of sensitivity because not all of the ions in a mass peak 
or in neighboring isotopic peaks are isolated. Too high a value causes interference 
from neighboring peaks.

Isolation offset Use this spin box to define an absolute offset by which the isolation window is 
shifted. The resulting window is non-symmetric with regard to the precursor m/z. 
Thus, more isotopes of a cluster might be covered, without the need of expanding 
the isolation window.

Example:
Precursor = m/z 524.265; Isolation window = 2.0 m/z; Isolation offset = +0.5 m/z;
Resulting isolation window = m/z 523.765–525.765

To change the isolation offset, click the arrows in the spin box to increment [up 
arrow] or decrement [down arrow] the value. You can set the isolation offset to any 
value from m/z -50 to +50. Default is m/z 0.

Fixed first mass Use this box to specify whether to use a first mass of the Data Dependent scan. After 
an automated determination of the detection mass range, the first mass will be set to 
the defined fixed first mass. Because only masses up to 15 times the first mass can be 
trapped in the C-Trap, loss of ions in the upper detection range may occur. 

To change the Fixed first mass, click the arrows in the spin box to increment [up 
arrow] or decrement [down arrow] the value. You can set Fixed first mass either to 
– (no Fixed first mass) or to any value from m/z 30 to 750. Default is –.

Parameter Description
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CE / Stepped CE Use this box to specify the collision energy (CE). This dimensionless number is 
approximately equivalent to the HCD collision energy (in eV) for a reference ion of 
mass 500 and charge 1. The actual HCD energy is calculated on basis of mass and 
charge of the selected precursor ion. 

If more than one CE value is entered, the Q Exactive GC mass spectrometer will 
perform a stepwise fragmentation on the precursor ion. All fragments created in the 
steps are collected and sent to the Orbitrap analyzer for one scan detection.

Enter up to three CE values manually separated by blanks or the locally defined “list 
separator” (defined for Microsoft™ Windows™ via the “Region and Language” 
settings).

Alternatively, click the down arrow to display a dialog box and select the 
corresponding number of check boxes. To change an CE value, click the arrows in 
the spin box to increment [up arrow] or decrement [down arrow] the value. You can 
set CE to any value from 10 to 200. Default is 30.

Spectrum data type Use this list box to toggle between Profile data format and Centroid data format.
dd Settings

Underfill ratio Use this box to specify a minimum percentage of the AGC Target value. If the mass 
peak of interest reaches this intensity within the Maximum IT, the Q Exactive GC 
mass spectrometer initiates a Data Dependent scan. The valid range is from 0 to 
100%.

Example: AGC Target = 1e5, Maximum IT = 250 ms, Underfill ratio = 1%: trigger 
threshold is 1000 charges in 250 ms.

Intensity threshold This field displays the minimum intensity that a mass peak requires to initiate a 
Data Dependent scan.

Parameter Description
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Apex trigger To obtain the highest quality data in the shortest period of time, it is best to defer 
data acquisition until near the apex of a chromatographic peak. Using the 
chromatographic peak apex detection provides numerous benefits for Data 
Dependent GC/MS/MS, including:
• Improved MS/MS quality and signal levels
• Shorter ion injection times
• Reduced MS/MS acquisition of chemical background
• Less dependence on static or dynamic exclusion lists
• Reduced retriggering of scans on tailing chromatographic peaks

Use this box to enter start (Minimum) and end (Maximum) of a retention time 
window in seconds relative to the occurrence of a precursor. If the Q Exactive GC 
mass spectrometer finds an apex within the window, it triggers a Data Dependent 
acquisition for the corresponding m/z or range of m/z. The mass spectrometer also 
triggers a Data Dependent scan when the end of the time window is reached 
without detecting an apex. The apex trigger always depends on other selection 
criteria (for example, intensity threshold).
• Minimum

Enter the minimum value for the time window (in seconds). You can enter any 
value from – (0) to 360. The default value is –.

• Maximum
Enter the maximum value for the time window (in seconds). You can enter any 
value from – (0) to 360. The default value is –.

Exclude isotopes Use this field to define a window around a reference Data Dependent mass 
(including dynamic exclusion list masses) inside which other peaks in the window 
will not trigger a subsequent data-dependent scan. Use this feature, for example, to 
exclude isotope clusters.

Available options are on (isotopes exclusion enabled) and – (isotopes exclusion 
disabled). Default setting is on.

Dynamic exclusion Use this box to enter a time (in seconds) to prevent an ion from triggering a 
subsequent Data Dependent scan after it has already triggered a Data Dependent 
scan. 

The following inputs are possible:
• – (no dynamic exclusion)
• 0.1 to 50000

Dynamic exclusion is valuable if the Q Exactive GC mass spectrometer has obtained 
enough data on an ion or if the base peak corresponds to a contaminant or an ion of 
non interest. If you enable dynamic exclusion, and if the mass spectrometer 
performs a Data Dependent scan on an ion, that ion is placed on the exclusion list (a 
temporary reject mass list) for a user-specified period of time. Then, when the mass 
spectrometer performs another Data Dependent scan on another ion, that ion is also 
placed on the exclusion list, and so on.

Parameter Description



Instrument Setup
Experiment Setup Page

3-36 Q Exactive GC Software Manual (P/N 1R120706-0003, Revision B) Thermo Scientific

❖ To show this view

Click the Targeted-SIM / dd-MS2 symbol in the Graph pane.
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Summary Page
The Summary page displays the parameters for mass spectrometer setup 
and contact closure that you specified on the Experiment Setup page.

❖ To zoom in or out on the Summary page

• Position the mouse pointer within the pane, press the <Ctrl> key, 
and roll the mouse wheel forward to zoom in.

• Position the mouse pointer within the pane, press the <Ctrl> key, 
and roll the wheel backward to zoom out.

NOTICE The content of this page will be printed together with the 
information for other instruments. ▲

❖ To display this page

In the Instrument Setup window, click the Summary tab.
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Dialog Boxes of the Experiment Setup Page
This section provides a reference to the dialog boxes in the Experiment 
Setup page:

• Use the dialog boxes for global lists to define properties of masses 
that are used for setting up the experiments in the Experiment Setup 
page:

- Lock Masses Dialog Box

- Inclusion List Dialog Box

- Exclusion List Dialog Box

- Tag Masses Dialog Box

• Mass Calculator

Lock Masses Dialog Box

Use the Lock Masses dialog box to select a lock mass list for the active 
instrument method and to edit it. See Figure 3-12. Lock masses are 
peaks in the spectrum that the Q Exactive GC mass spectrometer uses 
for internal mass calibration. Using lock masses improves the mass 
accuracy of the mass analyzer. If you do not specify any lock masses, the 
mass spectrometer uses the external mass calibration.

The dialog box allows defining a time window of activity for each lock 
mass (=timed lock masses). If Start or End is left blank, the lock mass is 
active from the beginning or until the end of the method, respectively. 
In the latter case, the End field displays “end.” The usage of lock masses 
during the active instrument method is specified on the Properties pane 
of the method.

The table shows the properties of the masses contained in the active lock 
mass list (*.lock-masses). To change the sort order, click the respective 
table column header. To invert the sort order, click again.

Figure 3-12. Method Editor—Lock Masses dialog box
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The Lock Masses dialog box has the following parameters:

❖ To display this dialog box

1. In the Method Editor, expand the Global Lists pane.

2. Click the  button.

Title Bar

The title bar of a global list displays the name of the dialog box. An 
asterisk (*) indicates a file with unsaved changes.

File Menu

The File menu provides commands for file operations. It has the 
following commands:

Parameter Description

Mass [m/z] Enter the mass-to-charge-ratio of the lock mass into the field (with a maximum of five 
decimals).

To change this value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value. Alternatively, enter a value in the spin box text field.

Polarity Use this list box to toggle between positive ion and negative ion polarity. During a scan, the 
Q Exactive GC mass spectrometer uses only the lock masses with a polarity that matches the 
active ion mode.

Start [min] Enter the start time in minutes. Alternatively, you can enter a time in seconds (by appending 
the letter s) or in hours (by appending the letter h). The software automatically converts your 
input into minutes.

End [min] Enter the end time in minutes. Alternatively, you can enter a time in seconds (by appending 
the letter s) or in hours (by appending the letter h). The software automatically converts your 
input into minutes.

Comment Enter a comment for the lock mass into the field. This field is optional.

Command Description

Import
<Ctrl> + <I>

Opens a dialog box where you can select an existing mass collection. In addition to 
the program-specific data files, you can select *.csv or *.txt files that meet the 
requirements of the program. All available masses are replaced by the masses 
contained in the imported file. Click Open to import the file.

Export
<Ctrl> + <S>

Opens a dialog box that you can use to save the active mass collection. In addition 
to using the program-specific data files, you can save the mass collection as 
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for 
example). Enter a new file name, select the file type, and select the location (disk 
and directory) where you want to save it. Alternatively, you can select an existing 
file. Click Save to save the file.
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Edit Menu

The Edit menu provides commands for editing the active file. It has the 
following commands:

Help Menu

Displays the Help for this dialog box.

Inclusion List Dialog Box

Use the Inclusion List dialog box to edit a list of specific masses 
(inclusion masses) that can activate a Data Dependent action. See 
Figure 3-13. The dialog box allows defining a time window of activity 
for each inclusion mass. If Start or End is left blank, the inclusion mass 
is active from the beginning or until the end of the method, respectively. 
In the latter case, the End field displays “end.”

Export selected
<Ctrl> + <Shift> + <S>

Opens a dialog box that you can use to save the selected masses. In addition to 
using the program-specific data files, you can save the mass collection as 
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for 
example). Enter a new file name, select the file type, and select the location (disk 
and directory) where you want to save it. Alternatively, you can select an existing 
file. Click Save to save the file.

This command is available only when at least one line in the dialog box is selected.

Minimize
<Ctrl> + <F4>

Closes the dialog box. Your edits will be retained. Alternatively, click the Done 
button at the right side of the menu bar.

Command Description

Command Description 

Undo until last save
<Ctrl> + <Z>

Discards all changes to the active file that have not been saved.

Copy
<Ctrl> + <C>

Copies the data of the selected mass to the clipboard.

Replace by clipboard
<Ctrl> + <V>

Replaces the available masses by the content of the clipboard.

NOTICE The clipboard stores lock mass data as tabulator-separated text files. When 
the data in the clipboard are not in this format, the command is not available. ▲
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To use an inclusion list in a experiment, set the Inclusion parameter on 
the Parameter pane to on. When a inclusion mass list is used in a Data 
Dependent experiment (Full MS / dd-MS2 and 
Targeted-SIM / dd-MS2), the ions will be selected for the Data 
Dependent scan event, only if they are: 

1. appearing in the referring master scan (mostly the full scan) and 

2. fulfill all of the other defined selection criteria, such as Intensity 
Threshold.

Because target-based experiments or experiment parts (Targeted-SIM, 
PRM, Targeted-SIM / dd-MS2) are based on an inclusion list, the 
Inclusion parameter is always set to on for these experiments.

The table shows the properties of the masses contained in the active 
inclusion masses list (*.include-masses). To change the sort order, click 
the respective table column header. To invert the sort order, click again.

The Inclusion List dialog box has the following parameters:

Figure 3-13. Method Editor—Inclusion List dialog box

Parameter Description

Mass [m/z] Enter the mass-to-charge-ratio of the inclusion mass into the field (with a maximum of five 
decimals).

NOTICE If you use the Mass Calculator to edit the Formula field, this field is automatically 
updated when you exit the editor. ▲



Instrument Setup
Dialog Boxes of the Experiment Setup Page

3-42 Q Exactive GC Software Manual (P/N 1R120706-0003, Revision B) Thermo Scientific

Formula [M] Use this field to describe the structure of the active compound. The different ways of 
definition are called formula types. You can either enter the formula directly or use the Mass 
Calculator. To display this editor, click the down arrow in this field. 

Pay attention to the following restrictions:
• When you enter a valid formula, the Method Editor will set the default values for 

charge state (1) and Species (+H/-H). Then it will display an automatically calculated 
value in the Mass [m/z] field.

• When you enter a formula that the Method Editor cannot interpret, the Mass [m/z] 
field will stay empty. When you save the method, the Method Editor will warn you that 
the method is not in the shape to be executed (due to the missing m/z value). When you 
reopen the method, the Method Editor will display exactly the formula that was 
entered.

• When you enter a formula, The Method Editor requires a value for the charge state to 
calculate an m/z value. You can, however, save the method without specifying a charge 
state for the entry. When you save the method, the Method Editor will warn you that 
the method is not in the shape to be executed (due to the missing charge state). When 
you reopen the method, the Method Editor will display exactly the formula that was 
entered.

• Entries of compounds with calculated m/z values outside the measurement 
specifications of the mass spectrometer (m/z=30–3000) can be saved in an instrument 
method. The instrument software, however, will ignore these entries when it executes 
the method.

• When you change the m/z value that was calculated for the given set of formula, species 
and charge state, the Method Editor will clear the formula and species definition. The 
charge state will be preserved.

• When you change the polarity for a set of calculated m/z, formula, species and charge 
state, the Method Editor will clear the Mass [m/z] field if the species definition is not 
valid for this polarity. You then need to change the species definition.

Parameter Description
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Species Use this text field to define adducts or modifications of the active compound that are 
expected to be formed. The default value is +H for positive polarity and –H for negative 
polarity. The Method Editor will then recalculate the value in the Mass [m/z] field, if 
possible.

The Species field can be used in two ways:

• Click the down arrow to display a list of predefined adducts for each polarity:

- +H, +NH4, +C2H5, +C3H5, +C4H9 for positive polarity

- -H for negative polarity

- an empty entry to express adducts (for example, radical cations) for both polarities.

The corresponding set will be displayed depending on the selected polarity. 

Selecting an adduct (A) will result in the strict behavior of applying one unit A to the 
compound and using “+H” or “-H” adduct depending on the charge state and active 
polarity.

• Enter the modifications of the compound by using squared brackets and at least M as 
representation of the basic compound. The predefined adducts can be entered, too. 
This definition is used without additional auto dependencies, like adding protons. 

NOTICE If you use the Mass Calculator to edit the Formula field, the Species field is 
automatically filled when you exit the editor. ▲

Polarity Use this list box to toggle between positive ion and negative ion polarity. During a scan, the 
Q Exactive GC mass spectrometer uses only the inclusion masses with a polarity that 
matches the active ion mode.

NOTICE If you use the Mass Calculator to edit the Formula field, this field is automatically 
updated when you exit the editor. ▲

Start [min] Enter the start of the time window (in minutes) that corresponds to the mass in this row. 
Alternatively, you can enter a time in seconds (by appending the letter s) or in hours (by 
appending the letter h). Q Exactive GC Tune automatically converts your input into 
minutes.

End [min] Enter the end of the time window in minutes. Alternatively, you can enter a time in seconds 
(by appending the letter s) or in hours (by appending the letter h). Q Exactive GC Tune 
automatically converts your input into minutes.

CE Use the spin box to enter the RF amplitude (as a percentage) used to fragment ions. The 
valid range is 10 to 200%. The default value is 35%. In the list, the software adds the prefix 
“ce:” to collision energy values (for example, ce:35).

A high collision energy value results in more energy deposition (which generally leads to 
more fragmentation). A low collision energy value results in less energy deposition (which 
generally leads to less fragmentation).

Parameter Description
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❖ To display this dialog box

1. In the Method Editor, expand the Global Lists pane.

2. Click the  button.

Title Bar

The title bar of a global list displays the name of the dialog box. An 
asterisk (*) indicates a file with unsaved changes.

File Menu

The File menu provides commands for file operations. It has the 
following commands:

MSX ID Enter the number of the multiplexed scan event in which the inclusion mass was analyzed.

Comment Enter a comment for the inclusion mass into the field. This field is optional.

Parameter Description

Command Description

Import
<Ctrl> + <I>

Opens a dialog box where you can select an existing mass collection. In addition to 
the program-specific data files, you can select *.csv or *.txt files that meet the 
requirements of the program. All available masses are replaced by the masses 
contained in the imported file. Click Open to import the file.

When you want to import *.csv or *.txt files with entries that contain formulas, an 
extra third column “Formula type,” which contains the prefix, must specify the 
formula type. Valid values for the fields that can be (re)interpreted are:
• for Peptide type: “Peptide”, “p”, and “p:” (all case insensitive),
• for Amino acid type: “Amino acid”, “aa”, “aa:” (all case insensitive),
• for Chemical formula type: “Chemical formula”, “c”, “c:” (all case insensitive), 

and “” (empty).

Export
<Ctrl> + <S>

Opens a dialog box that you can use to save the active mass collection. In addition 
to using the program-specific data files, you can save the mass collection as 
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for 
example). Enter a new file name, select the file type, and select the location (disk 
and directory) where you want to save it. Alternatively, you can select an existing 
file. Click Save to save the file.

When you export *.csv or *.txt files with entries that contain formulas, an extra 
third column “Formula type” specifies the formula type. Values for the fields that 
are:
• for Peptide type: “Peptide”,
• for Amino acid type: “Amino acid”,
• for Chemical formula type: “” (empty).
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Edit Menu

The Edit menu provides commands for editing the active file. It has the 
following commands:

Help Menu

Displays the Help for this dialog box.

Exclusion List Dialog Box

Use the Exclusion List dialog box to edit a list of specific masses 
(exclusion masses) that will not trigger a subsequent Data Dependent 
scan even if they are present. See Figure 3-14. The dialog box allows 
defining a time window of activity for each exclusion mass. If Start or 
End is left blank, the exclusion mass is active from the beginning or 
until the end of the method, respectively. In the latter case, the End field 
displays “end.”

To use an exclusion list in a experiment, set the Exclusion parameter on 
the Parameter pane to on.

Export selected
<Ctrl> + <Shift> + <S>

Opens a dialog box that you can use to save the selected masses. In addition to 
using the program-specific data files, you can save the mass collection as 
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for 
example). Enter a new file name, select the file type, and select the location (disk 
and directory) where you want to save it. Alternatively, you can select an existing 
file. Click Save to save the file.

This command is available only when at least one line in the dialog box is selected.

Minimize
<Ctrl> + <F4>

Closes the dialog box. Your edits will be retained. Alternatively, click the Done 
button at the right side of the menu bar.

Command Description

Command Description 

Undo until last save
<Ctrl> + <Z>

Discards all changes to the active file that have not been saved.

Copy
<Ctrl> + <C>

Copies the data of the selected mass to the clipboard.

Replace by clipboard
<Ctrl> + <V>

Replaces the available masses by the content of the clipboard.

NOTICE The clipboard stores lock mass data as tabulator-separated text files. When 
the data in the clipboard are not in this format, the command is not available. ▲
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The table shows the properties of the masses contained in the active 
exclusion masses list (*.exclude-masses). To change the sort order, click 
the respective table column header. To invert the sort order, click again.

The Exclusion List dialog box has the following parameters:

Figure 3-14. Method Editor—Exclusion List dialog box

Parameter Description

Mass [m/z] Enter the mass-to-charge-ratio of the exclusion mass into the field (with a maximum of five 
decimals).

NOTICE If you use the Mass Calculator to edit the Formula field, this field is automatically 
updated when you exit the editor. ▲

Formula [M] Use this field to describe the structure of the active compound. You can either enter the 
formula directly or use the Mass Calculator. To display this editor, click the down arrow in 
this field. 

Pay attention to the following restrictions:
• When you enter a valid formula, the Method Editor will set the default values for charge 

state (1) and Species (+H/–H). Then it will display an automatically calculated value in 
the Mass [m/z] field.

• When you enter a formula that the Method Editor cannot interpret, the Mass [m/z] field 
will stay empty. When you save the method, the Method Editor will warn you that the 
method is not in the shape to be executed (due to the missing m/z value). When you 
reopen the method, the Method Editor will display exactly the formula that was entered.

• When you enter a formula, The Method Editor requires a value for the charge state to 
calculate an m/z value. You can, however, save the method without specifying a charge 
state for the entry. When you save the method, the Method Editor will warn you that the 
method is not in the shape to be executed (due to the missing charge state). When you 
reopen the method, the Method Editor will display exactly the formula that was entered.

• Entries of compounds with calculated m/z values outside the measurement specifications 
of the mass spectrometer (m/z=30–3000) can be saved in an instrument method. The 
instrument software, however, will ignore these entries when it executes the method.

• When you change the m/z value that was calculated for the given set of formula, species 
and charge state, the Method Editor will clear the formula and species definition. The 
charge state will be preserved.

• When you change the polarity for a set of calculated m/z, formula, species and charge 
state, the Method Editor will clear the Mass [m/z] field if the species definition is not 
valid for this polarity. You then need to change the species definition.
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❖ To display this dialog box

1. In the Method Editor, expand the Global Lists pane.

2. Click the  button.

Species Use this field to define adducts or modifications of the active compound that are expected to 
be formed. The default value is +H for positive polarity and –H for negative polarity. The 
Method Editor will then recalculate the value in the Mass [m/z] field, if possible.

The Species field can be used in two ways:

• Click the down arrow to display a list of predefined adducts for each polarity:

- +H, +NH4, +C2H5, +C3H5+, +C4H9 for positive polarity

- -H for negative polarity

- an empty entry to express adducts (for example, radical cations) for both polarities.

The corresponding set will be displayed depending on the selected polarity. 

Selecting an adduct (A) will result in the strict behavior of applying one unit A to the 
compound and using “+H” or “-H” adduct depending on charge state and active 
polarity.

• Enter the modifications of the compound by using squared brackets and at least M as 
representation of the basic compound. The predefined adducts can be entered, too. This 
definition is used without additional auto dependencies, like adding protons. 

If you select or define a species and the Formula field is empty, the species definition will stay 
grayed out.

NOTICE If you use the Mass Calculator to edit the Formula field, this field is automatically 
updated when you exit the editor. ▲

Polarity Use this list box to toggle between positive ion and negative ion polarity. During a scan, the 
Q Exactive GC mass spectrometer uses only the exclusion masses with a polarity that 
matches the active ion mode.

NOTICE If you use the Mass Calculator to edit the Formula field, this field is automatically 
updated when you exit the editor. ▲

Start [min] Enter the start of the time window (in minutes) that corresponds to the mass in this row. 
Alternatively, you can enter a time in seconds (by appending the letter s) or in hours (by 
appending the letter h). The software automatically converts your input into minutes.

End [min] Enter the end of the time window in minutes. Alternatively, you can enter a time in seconds 
(by appending the letter s) or in hours (by appending the letter h). The software 
automatically converts your input into minutes.

Comment Enter a comment for the exclusion mass into the field. This field is optional.

Parameter Description
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Title Bar

The title bar of a global list displays the name of the dialog box. An 
asterisk (*)indicates a file with unsaved changes.

File Menu

The File menu provides commands for file operations. It has the 
following commands:

Command Description

Import
<Ctrl> + <I>

Opens a dialog box where you can select an existing mass collection. In addition to 
the program-specific data files, you can select *.csv or *.txt files that meet the 
requirements of the program. All available masses are replaced by the masses 
contained in the imported file. Click Open to import the file.

When you want to import *.csv or *.txt files with entries that contain formulas, an 
extra third column “Formula type,” which contains the prefix, must specify the 
formula type. Valid values for the field that can be (re)interpreted are:
• for Chemical formula type: “Chemical formula”, “c”, “c:” (all case insensitive), 

and “” (empty).

Export
<Ctrl> + <S>

Opens a dialog box that you can use to save the active mass collection. In addition 
to using the program-specific data files, you can save the mass collection as 
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for 
example). Enter a new file name, select the file type, and select the location (disk 
and directory) where you want to save it. Alternatively, you can select an existing 
file. Click Save to save the file.

When you export *.csv or *.txt files with entries that contain formulas, an extra 
third column “Formula type” specifies the formula type. The value for the field is:
• for Chemical formula type: “” (empty).

Export selected
<Ctrl> + <Shift> + <S>

Opens a dialog box that you can use to save the selected masses. In addition to 
using the program-specific data files, you can save the mass collection as 
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for 
example). Enter a new file name, select the file type, and select the location (disk 
and directory) where you want to save it. Alternatively, you can select an existing 
file. Click Save to save the file.

This command is available only when at least one line in the dialog box is selected.

Minimize
<Ctrl> + <F4>

Closes the dialog box. Your edits will be retained. Alternatively, click the Done 
button at the right side of the menu bar.
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Edit Menu

The Edit menu provides commands for editing the active file. It has the 
following commands:

Help Menu

Displays the Help for this dialog box.

Tag Masses Dialog Box

An MS/MS scan can be triggered by a mass that has a ‘partner’ mass a 
user-defined delta away. Use the Tag Masses dialog box to edit a list of 
such mass deltas. See Figure 3-12. This is useful for applications where 
mass tags are used, or where mass pairs are known, and can greatly 
reduce the number of MS/MS scans on non-tagged species.

Tag masses can be used only in the Full MS / dd-MS2 experiment. To 
use tag masses, set the Tags parameter on the Parameter pane to on.

The table displays the properties of the available tag masses. To change 
the sort order, click the respective table column header. To invert the 
sort order, click again.

Command Description 

Undo until last save
<Ctrl> + <Z>

Discards all changes to the active file that have not been saved.

Copy
<Ctrl> + <C>

Copies the data of the selected mass to the clipboard.

Replace by clipboard
<Ctrl> + <V>

Replaces the available masses by the content of the clipboard.

NOTICE The clipboard stores lock mass data as tabulator-separated text files. When 
the data in the clipboard are not in this format, the command is not available. ▲

Figure 3-15. Method Editor—Tag Masses dialog box



Instrument Setup
Dialog Boxes of the Experiment Setup Page

3-50 Q Exactive GC Software Manual (P/N 1R120706-0003, Revision B) Thermo Scientific

The Tag Masses dialog box has the following parameters:

❖ To display this dialog box

1. In the Method Editor, expand the Global Lists pane.

2. Click the  button.

Title Bar

The title bar of a global list displays the name of the dialog box. An 
asterisk (*) indicates a file with unsaved changes.

File Menu

The File menu provides commands for file operations. It has the 
following commands:

Parameter Description

 Mass [m/z] Use this spin box to enter the mass difference (with 
a maximum of five decimals). Depending on the 
sign, one precursor of the pair will be triggered. If 
you want to trigger on the heavy precursor (with a 
tag or isotope label), you need to enter a negative 
sign (for example, –6.02). It will be checked if an 
m/z distance towards lower m/z will be found. If so, 
the precursor at higher m/z will be selected. A 
positive m/z distance leads to the selection of the 
precursor with a lower m/z. If both precursors 
should be selected, two entries are needed, one with 
positive and one with negative sign.

The valid range is 0.00001 to ±4000.00000.

Comment Enter a comment into the field. This field is 
optional.

Command Description

Import
<Ctrl> + <I>

Opens a dialog box where you can select an existing mass collection. In addition to 
the program-specific data files, you can select *.csv or *.txt files that meet the 
requirements of the program. All available masses are replaced by the masses 
contained in the imported file. Click Open to import the file.

Export
<Ctrl> + <S>

Opens a dialog box that you can use to save the active mass collection. In addition 
to using the program-specific data files, you can save the mass collection as 
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for 
example). Enter a new file name, select the file type, and select the location (disk 
and directory) where you want to save it. Alternatively, you can select an existing 
file. Click Save to save the file.



Instrument Setup
Dialog Boxes of the Experiment Setup Page

Thermo Scientific Q Exactive GC Software Manual (P/N 1R120706-0003, Revision B) 3-51

Edit Menu

The Edit menu provides commands for editing the active file. It has the 
following commands:

Help Menu

Displays the Help for this dialog box.

Export selected
<Ctrl> + <Shift> + <S>

Opens a dialog box that you can use to save the selected masses. In addition to 
using the program-specific data files, you can save the mass collection as 
tabulator-separated file (*.txt, for example) or comma-separated file (*.csv, for 
example). Enter a new file name, select the file type, and select the location (disk 
and directory) where you want to save it. Alternatively, you can select an existing 
file. Click Save to save the file.

This command is available only when at least one line in the dialog box is selected.

Minimize
<Ctrl> + <F4>

Closes the dialog box. Your edits will be retained. Alternatively, click the Done 
button at the right side of the menu bar.

Command Description

Command Description 

Undo until last save
<Ctrl> + <Z>

Discards all changes to the active file that have not been saved.

Copy
<Ctrl> + <C>

Copies the data of the selected mass to the clipboard.

Replace by clipboard
<Ctrl> + <V>

Replaces the available masses by the content of the clipboard.

NOTICE The clipboard stores lock mass data as tabulator-separated text files. When 
the data in the clipboard are not in this format, the command is not available. ▲



Instrument Setup
Dialog Boxes of the Experiment Setup Page

3-52 Q Exactive GC Software Manual (P/N 1R120706-0003, Revision B) Thermo Scientific

Mass Calculator

Use the Mass Calculator to specify the properties of compounds that are 
used in the Inclusion List dialog box and the Exclusion List dialog box.

When you display the Mass Calculator, its fields are filled with the 
values of the active list fields, if available. Otherwise, its fields are filled 
with the default values. The Method Editor applies the set and 
calculated values of the Mass Calculator to the active list fields, when 
you exit the editor by doing one of the following:

• Press Enter at any position.

• Click at any position outside of the editor.

• Click the down arrow in the Formula field again.

The Mass Calculator has the following parameters:

Figure 3-16. Mass Calculator (Method Editor)

Parameter Description

Compound

Formula Use the text field to specify the basic composition of the compound. Click the 
down arrow to display a list of the last entered compounds.

The syntax rules and interpretation accept the kind of formula that is also 
accepted on the Spectrum Simulation page (Isotope Simulation area) of the 
Qual Browser.

Type Use the Type list to specify the formula type used in the Formula field:
• Chemical formula Formula is defined as the resulting elemental 

composition of the entered formula. This is the default selection.

Independent of the entry in the Species field, the elemental composition and the 
mass of the compound, Formula is completely determined by the given formula 
and selected formula type.
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❖ To display the Mass Calculator

Click the down arrow in a Formula cell of the Inclusion List dialog 
box or the Exclusion List dialog box.

Species Use this text field to define adducts or modifications of the active compound 
that are expected to be formed. The default value is +H for positive polarity and 
–H for negative polarity.

The Species field can be used in two ways:

• Click the down arrow to display a list of predefined adducts for each 
polarity:

- +H, +NH4, +C2H5, +C3H5, +C4H9 for positive polarity

- -H for negative polarity

- an empty entry to express adducts (for example, radical cations) for both 
polarities.

The corresponding set will be displayed depending on the selected polarity. 

Selecting an adduct (A) will result in the strict behavior of applying one unit 
A to the compound and using “+H” or “-H” adduct depending on the 
charge state and active polarity.

• Enter the modifications of the compound by using squared brackets and at 
least M as representation of the basic compound. The predefined adducts 
can be entered, too. This definition is used without additional auto 
dependencies, like adding protons. 

Charge state Use the list box to select the resulting charge state. Available options are 1+ to 
25+ for positive polarity and 1– to 25– for negative polarity. The default charge 
state is 1+ for positive polarity and 1– for negative polarity.

Polarity Use the option buttons to select the applied polarity. The default polarity is 
positive.

m/z This text field displays the calculated mass-to-charge ratio, with five decimal 
places (for example, 524.26496).

Composition This text field displays the determined total formula (for example, C23 H38 N7 
O5 S).

Parameter Description
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Chapter 4 Explore Q Exactive GC Tune

This chapter provides information about Q Exactive GC Tune, its 
views, functions, and features.

Contents

• Q Exactive GC Tune Overview

• Q Exactive GC Tune Menus

• Toolbar

• Tasks Panel

• Display Panel

• Dialog Boxes

• Tune Reports
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Q Exactive GC Tune Overview
The Q Exactive GC Tune program is used to operate the 
Q Exactive GC mass spectrometer. Figure 4-1 shows Q Exactive GC 
Tune. To access information about Q Exactive GC Tune, use the title 
bar, the toolbar, menu commands, display views, and Help.

❖ To display this window

• Choose Start > Programs > Thermo Exactive Series > Tune, or

• Click  on the desktop.

NOTICE When you are running Q Exactive GC Tune, an 
Q Exactive GC Tune icon ( ) is displayed in the Microsoft™ 
Windows™ system tray. Double-click the  icon to display the 
Q Exactive GC Tune window when it is minimized. Right-click the  
icon to display a shortcut menu that provides commands for restoring or 
terminating Q Exactive GC Tune. ▲

Title Bar

The Q Exactive GC Tune title bar displays the name of the program, 
the name of the current Tune Method, and the instrument status. An 
asterisk indicates a Tune Method with unsaved changes.

Figure 4-1. Q Exactive GC Tune
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Menus

The Q Exactive GC Tune menu bar displays the available menus. The 
Q Exactive GC Tune menus are as follows:

• File Menu

• Windows Menu

• Reports Menu

• Help Menu

On the far right side of the menu bar, the active user role is displayed.

Toolbar

The Toolbar provides symbol shortcuts for frequently used commands. 
It is located below the title bar of the Q Exactive GC Tune window. 

Tasks Panel

The tasks panel on the left side of the Q Exactive GC Tune window 
comprises five windows:

• The Instrument Control Window on the left side of the 
Q Exactive GC Tune window comprises three windows:

 Scan Parameters Window for defining a scan depending on the 
scan mode and scan type combination.

 EI/CI Source Window for displaying and editing parameters of 
the EI or CI ion source. 

 Click the EI/CI source window title bar in the Instrument 
Control window.Acquisition Window for acquiring and storing 
measurement data.

• Mass Traces Window for selecting mass traces that are displayed in 
the Analysis Graphs Window.

• Calibrate Window for performing an automatic optimization of the 
calibration parameters.

• Evaluate Window for performing an automatic check of the 
instrument precision.

• Vacuum / Bakeout Window for displaying the pressure values at the 
vacuum gauges and performing an instrument bakeout.
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Display Panel

The display panel on the right side of the Q Exactive GC Tune window 
comprises up to five windows:

• Spectrum Window for displaying a real-time data plot. The 
spectrum window is always visible.

• Instrument Status Window for displaying instrument parameters.

• Messages Window for displaying current status information about 
the instrument, the control service, or other programs.

• Analysis Graphs Window for displaying a real-time graph.

• Debug Messages Window for displaying messages that can be used 
during software development. The debug messages window is not 
available for standard users.

In addition to these five windows, the display panel may show 
additional windows for controlling other installed instruments.
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Q Exactive GC Tune Menus
The Q Exactive GC Tune window has the following menus:

• File Menu

• Windows Menu

• Reports Menu

• Help Menu

User Role

On the far right side of the menu bar, the active user role is displayed. 
The user role specifies the number of parameters that are available for 
the active experiment. Standard User is the user role with the lowest 
number of available parameters.

Click the entry (Advanced, for example) to display a list that displays the 
available user roles. To change the active user role, click the respective 
entry. The number of available user roles depends on the installed 
licenses. See “License Dialog Box” on page 4-49.

File Menu

The File menu provides commands for file and program operations. It 
has the following commands:

Command Description

Load Tune File Displays a dialog box that you can use to find and 
open a tune file (*.mstune) that already exists.

Save Tune File Saves the active tune file with the current settings.

Save Tune File as Opens a dialog box that you can use to enter a new 
file name and to select the location (disk and 
directory) where you want to save it. Click Save to 
save the tune file with the current settings.

NOTICE An * appears next to the tune file name 
displayed in the title bar of tune if the current tune 
file has been modified and not saved. Any changes 
made to the tune file must be saved before 
attempting to use the new setting from an 
acquisition that loads the tune file in a method.
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Windows Menu

The Windows menu provides commands for customizing the 
information displayed in the Q Exactive GC Tune window. The system 
highlights the icon to the left of a command if the window is active. 
Deselect the command to hide the window.

The Windows menu has the following commands:

Export System 
Settings

Opens a dialog box that you can use to save the 
current system settings (*.ini) to be imported on 
another computer that has no instrument attached 
and is intended for method editing. This computer 
has to have installed all needed software including 
Thermo Platform, Thermo Xcalibur and all 
instrument drivers installed.

NOTICE Imported values will be overwritten if an 
instrument will be attached later. ▲

Terminate Closes the active window. If the active tune file 
contains unsaved changes, a dialog box warns about 
losing data when you terminate the program.

Command Description

Command Description

View > Show all Displays all windows of Q Exactive GC 
Tune.

Tooltips Displays a short description of an item on 
the Q Exactive GC Tune window when you 
rest the mouse pointer over it.

Spectrum Displays the Spectrum window.

The Spectrum Window is always visible.

Instrument Status Displays/Hides the Instrument Status 
window.

Messages Displays/Hides the Messages window.

Analysis Graphs Displays/Hides the Analysis Graphs window.

Debug Messages Displays/Hides the Debug Messages 
window.

The debug messages window is not available 
for standard users.
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NOTICE Q Exactive GC Tune may open some windows (the analysis 
graphs window, for example) without user interaction if new important 
information is available. ▲

Reports Menu

The Reports menu provides access to various calibration reports. The 
individual commands are available only when the respective reports have 
been created. If no reports exist (in a new system, for example), the 
Reports menu is shown grayed out and has no commands.

The Reports menu has the following commands:

Mass Calculator Displays the Mass Calculator, which helps 
you to calculate the mass of an compound of 
interest.

Installed 
instruments

Depending on the individual configuration 
of your system, additional commands may 
allow displaying windows for controlling 
other installed instruments (TriPlus RSH 
autosampler, for example.)

Command Description

Command Description

Calibration > Latest Opens the latest complete calibration 
report in PDF format.

Calibration > List Displays the list of up to five (5) 
complete calibration reports.

To open a report, double-click any of the 
calibration from the list.

Spectral Mass Calibration 
(neg) > Latest

Opens the latest negative mode 
calibration report in PDF format.

Spectral Mass Calibration 
(neg) > List

Displays the list of up to five (5) negative 
mode calibration reports.

To open a report, double-click any of the 
spectral mass calibration from the list.

Spectral Mass Calibration 
(pos) > Latest

Opens the latest positive mode 
calibration report in PDF format.
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Help Menu

The Help menu groups commands that provide information about 
Q Exactive GC Tune. It has the following commands:

EI Tune Report The choices are Latest and List. Latest 
displays the most recent EI Tune report. 
List displays the list of up to five (5) 
reports.

To open a report, double-click any of the 
tune reports from the list.

Spectral Mass Calibration 
(pos) > List

Displays the list of up to five (5) positive 
mode calibration reports.

To open a report, double-click any of the 
spectral mass calibration from the list.

All Reports Opens a file manager window with a list 
of all previously acquired spectral mass 
calibration reports.

Command Description

Command Description

Help Overview Displays Q Exactive GC Tune Help.

Help Content Displays the table of contents for Q Exactive GC 
Tune Help.

Help Index Displays the index for Q Exactive GC Tune Help.

About Displays the About dialog box with information 
about the instrument and the current 
Q Exactive GC Tune version.
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Toolbar
The Q Exactive GC Tune toolbar provides symbol shortcuts for 
frequently used commands. It is located below the title bar of the 
Q Exactive GC Tune window. To activate a toolbar function, click the 
corresponding toolbar button.

Some symbols provide information about the current statuses of 
respective instrument components either by their color or by displaying 
a tooltip when you rest the mouse pointer on them.

The following functions are available:

Button Description

General instrument state

On / Standby / Off

Run by Xcalibur

Click to toggle between the instrument operating statuses On, 
Standby, and Off. The button reflects the instrument status:
• When the mass spectrometer is On, Q Exactive GC Tune 

displays .
• When the mass spectrometer is in Standby, Q Exactive GC 

Tune displays .

• When the mass spectrometer is Off, Q Exactive GC Tune 

displays .

If the mass spectrometer is controlled by an Xcalibur sequence, 

Q Exactive GC Tune displays . The acquisition can only be 
stopped from Xcalibur Sequence Setup View.

Open Click to display a dialog box that you can use to find and open a 
*.mstune file that already exists. Alternatively, choose File > Load 
Tune File.

Save Click to open a dialog box that you can use to select the location 
(disk and directory) where you want to save the tune file. 
Alternatively, choose File > Save Tune File as.

This button is not available when the settings of the active tune 
file are not changed.
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Communication Status Shows the actual communication status of the system:
• Green: communication with instrument is OK.
• Yellow: only service is accessible (no instrument).
• Red: communication is broken (no instrument, no service).

Hardware Status Shows the actual hardware status of the system (top instrument 
tree state):
• Green: all readbacks are in specifications (green hooks).
• Red: one or more readbacks are out of range.

Performance Status Shows the actual performance status of the system:
• Green: the last evaluation/calibration was successful.
• Yellow: the last evaluation/calibration was successful, but is 

out of date.
• Red: the evaluation/calibration was not successful.

By default, the performance status icon turns yellow 25 hours 
after the last successful mass calibration or check. With exception 
of standard users, users can change this value in the System node 
of the instrument status window according to their mass accuracy 
requirements.

Procedure active If a procedure is active (for example, system bakeout or tune) 
Q Exactive GC Tune displays an animated icon next to the 
performance status button.

Acquisition indicator If the mass spectrometer is acquiring data, Q Exactive GC Tune 
displays an animated icon next to the performance status button.

Button Description
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Tasks Panel
Use the windows of the tasks panel to perform procedures that maintain 
the quality of measurements with the Q Exactive GC mass 
spectrometer.

The tasks panel is always visible. The windows in the tasks panel can be 
minimized or maximized. Click the title bar of an individual window to 
display it.

• Instrument Control Window

• Mass Traces Window

• Calibrate Window

• Evaluate Window

• Vacuum / Bakeout Window

Instrument Control Window

Use the windows of the Instrument Control window to enter individual 
physical settings and to acquire scans. The following windows are 
available:

• Scan Parameters Window

• EI/CI Source Window 

• Click the EI/CI source window title bar in the Instrument Control 
window.Acquisition Window

The Instrument Control window is always visible. Click the title bar of 
an individual window to display it. Click again to hide it. To change the 
order of windows within the Instrument Control window, drag 
individual windows by their title bars to the new places.
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Scan Parameters Window

Use the Scan Parameters window to define a scan depending on the 
selected scan mode and scan type combination. See Figure 4-2. The 
Q Exactive GC mass spectrometer updates the scan parameters only 
after you click Apply or select the Hot link check box.

The Scan Parameters window has the following parameters:

Figure 4-2. Scan Parameters window

Parameter  Description

History Click to display the Scan Parameters History dialog box. Here, select from a list of 
recent scans based on short scan descriptions. The maximum number of list items is 
100.

After a change of parameters, the history is updated when you click Apply or when 
you change the status of the Hot link check box.

Scan Type Displays the current scan type. To change the settings, click into the field to display 
the Scan Type dialog box.

Scan Range Displays the current scan range. To change the settings, click into the field to 
display the Scan Range dialog box.

Fragmentation Displays the current settings for HCD fragmentation. If no fragmentation type is 
selected, the text field shows None. To change the settings, click into the field to 
display the Fragmentation dialog box.

Resolution Use this list box to select the mass resolution for FTMS analysis. The mass 
resolution of the Orbitrap analyzer is proportional to 1/sqrt(m/z). The scan time 
increases with increasing resolution and detect time. Available options are 15000, 
30000, 60000, or 120000. Resolution is calculated according to the IUPAC peak 
width definition. The available settings represent m/∆m or the m/z value of an ion 
at m/z 200 divided by the full width at half its maximum height (FWHM).

Polarity Use this list box to toggle between positive ion and negative ion polarity.
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❖ To display this window

Click the Scan Parameters window title bar in the Instrument 
Control window.

Microscans Use this spin box to select the number of microscans to be performed. To change 
the value, click the arrows in the spin box to increment [up arrow] or decrement 
[down arrow] the value. Alternatively, you can enter a value in the spin box text 
field. The valid range is from 1 to 10 microscans.

Lock masses Displays the active lock masses. During a scan, the Q Exactive GC mass 
spectrometer uses only the lock masses with a polarity that matches the ion mode. 
If no lock masses are selected, the text field shows Off. To change the settings, click 
into the field to display the Lock Masses dialog box.

NOTICE Q Exactive GC Tune allows using active lock masses in user-defined 
calibration mass lists. ▲

AGC target Use this list box to select the AGC target value. The AGC target value controls the 
number of ions that are injected into the Orbitrap analyzer. Available options are 
2e4, 5e4, 1e5, 2e5, 5e5, 1e6, 3e6, and 5e6.

Maximum inject time Use this list box to type or click a maximum injection time for AGC. For example, 
type 160. The valid range is from 1 to 3000 milliseconds.

Buttons

Apply Sends all changes to the instrument.

Help Displays the Help for this window.

Hot Link Select the Hot link check box to allow Q Exactive GC Tune to send any changes 
immediately to the instrument. A green frame around the parameter box indicates 
an active hot link.

Parameter  Description
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EI/CI Source Window

Use the EI/CI source window to specify electrical ionization (EI) or 
chemical ionization (CI) source parameters. The Q Exactive GC mass 
spectrometer updates the EI/CI source parameters only after you click 
Apply or with the Hot link check box being selected. See Figure 4-3.

The EI/CI source window has the following parameters:

Figure 4-3. EI/CI source window

Parameter Description

MS Transfer Line Temp Displays the temperature (in °C) for the part of the transfer line that’s inside the 
vacuum manifold. To change the MS transfer line temperature, enter a new 
temperature into the box. Temperatures from 200 – 280 °C are recommend for 
most applications.The mass spectrometer changes the MS transfer line 
temperature when you click Apply or with the Hot link check box selected.

The MS Transfer Line Temp readback is to the right of the spin box. This 
readback displays the actual flow rate (in °C).

Ion Source Temp Displays the ion source temperature. Temperatures from 200 – 350 °C are 
recommend for most applications. To change the ion source temperature, enter a 
new temperature into the box.The mass spectrometer changes the ion source 
temperature when you click Apply or with the Hot link check box selected.

The Ion Source Temp readback is to the right of the spin box. This readback 
displays the actual flow rate (in °C).

Filament Displays whether the filament is turned on or off. The choices are On or Off and 
can be set in the drop-down menu. source. To preserved the filament lifetime, set 
to off when not using the mass spectrometer. The mass spectrometer changes the 
Filament setting when you click Apply or with the Hot link check box selected.

Calibration Gas Displays whether the calibration gas is turned on. The choices are On or Off and 
can be set in the drop-down menu. source. To preserved the calibration gas, set to 
off when not running an analysis or checking for leaks on the mass spectrometer. 
The mass spectrometer changes the Calibration Gas setting when you click Apply 
or with the Hot link check box selected.
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Ionization Mode Displays either EI or CI ionization mode depending on the ion source installed in 
the Q Exactive GC mass spectrometer. The CI or EI/CI ion volume must be 
installed in the ion source cartridge to use CI ionization mode. Also, the mode 
must be set to CI to turn on CI gas. The mass spectrometer changes the ionization 
mode when you click Apply or with the Hot link check box selected.

CI Gas Flow Displays the CI gas flow rate (in mL/min). To change the CI gas flow rate, enter a 
value in the spin box text field. The mass spectrometer changes CI gas flow rate 
when you click Apply or with the Hot link check box selected.

The CI Gas Flow readback is to the right of the spin box. This readback displays 
the actual flow rate (in mL/min) of the CI gas.

CI Gas Port Displays the port connected to the CI gas. The choices are Port A and Port B if 
CI is selected as the ionization mode. If EI is the selected ionization mode the field 
is automatically set to None. To change the CI gas port, select Port A or Port B 
depending on which port is attached to the CI gas. The mass spectrometer 
changes the CI gas port when you click Apply or with the Hot link check box 
selected.

CI Gas Type Displays the type of CI gas to be used for the analysis. Selection options are 
Methane, Isobutane, Ammonia, Carbon Dioxide, or Other. Use the spin box to 
select one of the choices. The mass spectrometer changes the CI gas type when 
you click Apply or with the Hot link check box selected.

Buttons

Apply Sends all changes to the instrument.

Help Displays the Help for this window.

Hot Link Select the Hot link check box to allow Q Exactive GC Tune to send any changes 
immediately to the instrument. A green frame around the parameter box indicates 
an active hot link.

Parameter Description
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❖ To display this window

Click the EI/CI source window title bar in the Instrument Control window.Acquisition Window

Use the Acquisition window to enter parameters for acquiring and 
storing scan data as well as to monitor the progress of the active 
acquisition.

The Acquisition window has the following parameters:

Figure 4-4. Acquisition window

Parameter Description

Acquisition state Displays the status of the current acquisition.

Progress Displays the elapsed time of the current acquisition.

File in use Displays the name of the raw file to be acquired to disk for the current sample. To 
display the file in Qual Browser, click the  button.

This value is up to date even when Q Exactive GC Tune is acquiring data under control 
of Xcalibur.

Destination file Displays the full path of the folder where your *.raw files will be saved. To change the 
path, type the full path (Drive:\path) in the text box or click the  button to the right 
of the text box to browse your directories and select the folder where your *.raw files 
should be saved.

NOTICE Saving raw files on network drives typically causes problems. Preferably select a 
local path (for example, C:\Xcalibur\data). ▲
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Method file Displays the name of the instrument method (*.meth) to be used during the current 
acquisition. The tune file used in that instrument method will be used for your scan but 
other devices configured in that instrument method will not be included. Type in the 
name of the instrument method, or click the  button to the right of the text box to 
browse your computer for an instrument method file (typically saved in 
C:\Xcalibur\methods).

When the active acquisition is controlled by the settings of the parameter Acquisitions 
time, this parameter is not available. Instead, the text field shows by time.

Sample Displays the name of the current sample. To change the sample name, type the new 
name in the text field. 

Comment Displays a comment on the current sample, if available. To change the comment, type 
the new name in the text field. 

Acquisition time Displays the duration of the acquisition time. Use the option buttons to select one of 
the following settings:
• Continuously

The acquisition, once it is started, will continue until you stop (Stop button) or 
pause (Pause button) it.

• Scans
Specify the number of scans for the current acquisition. You can set the number of 
scans to any value from 1 to 10000.
To change this value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Alternatively, enter a value in the spin box text 
field.

• Minutes
Specify the time in minutes for the current acquisition. You can set the acquisition 
time from 0.01 to 15000.00 minutes.
To change this value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Alternatively, enter a value in the spin box text 
field.

When the active acquisition is controlled by a method file, this parameter is not 
available. Instead, the text field shows by method.

On start Use the list box to set the start mode of the data acquisition. The options are as follows:
• don’t wait

Initiates acquisition of the raw file immediately when you click Start in the 
Acquisition window.

• wait for contact closure
When you click Start in the Acquisition window, the acquisition pauses. 
Q Exactive GC Tune initiates acquisition of the raw file either when it receives a 
contact closure signal (for example, from an analog autosampler) or when you click 
Resume.

Parameter Description
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❖ To display this window

Click the Acquisition window title bar in the Instrument Control 
window.

After acquisition Use the list box to set the instrument mode after the data acquisition has stopped. The 
options are as follows:
• stay on

The instrument remains On when the current acquisition is completed.
• enter standby mode

Sets the instrument to Standby when the current acquisition is completed.
• switch off

Switches Off the instrument when the current acquisition is completed.
Buttons

Start / Stop Allows starting and stopping data acquisition. When no acquisition is in progress, 
Q Exactive GC Tune displays Start. When an acquisition is in progress, Q Exactive GC 
Tune displays Stop. To start an acquisition, click Start. To stop an acquisition, click 
Stop. To pause an acquisition, click the Pause / Resume button.

NOTICE No Q Exactive GC Tune controlled data acquisition is possible if the 
instrument is controlled by Xcalibur or TraceFinder. ▲

Pause / Resume Allows pausing and resuming an acquisition in progress. When no acquisition is in 
progress, the button is inactive (gray). When an acquisition is in progress, 
Q Exactive GC Tune displays Pause. When an acquisition is paused, Q Exactive GC 
Tune displays Resume. To pause an acquisition in progress, click Pause. To resume an 
acquisition that is paused, click Resume. To stop an acquisition in progress, click the 
Start / Stop button.

NOTICE The acquisition can be started by pressing Resume if the mass spectrometer is 
waiting for contact closure. ▲

Help Displays the Help for this window.

Parameter Description



Explore Q Exactive GC Tune
Tasks Panel

Thermo Scientific Q Exactive GC Software Manual (P/N 1R120706-0003, Revision B) 4-19

Tune Window

Use the Tune window to d automatically tune the Q Exactive GC 
mass spectrometer window. A daily tune and calibration are 
suggested for the Q Exactive GC instrument. Select AutoTune to 
use the last tuned values. See Figure 4-6. 

NOTICE The calibration gas and filament must be turned on before 
tuning the Q Exactive GC instrument. ▲

The Tune window has the following parameters:

Figure 4-5. Tune window

Parameter Description

Tune

TIC Select this check box to tune on the total ion current.

Mass Select an m/z value that you want to tune on. You can set the mass-to-charge 
ratio to any value from m/z 30 to m/z 3000.

To change this value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Alternatively, enter a value in the spin box 
text field.

Elements Check AutoTune to use the last tuned values. In advanced user mode, you can 
leave AutoTune unchecked and change individual tune values in Instrument 
Status > Tune Values. If a cleaned source is inserted in the instrument, check 
Preset Defaults to tune to the original Tune default values.

Buttons

Start Click Start to start tuning the instrument. The instrument needs to be in On 
status to start a plotting procedure.

When tuning is in progress, the Q Exactive GC Tune displays Stop.

Stop Click Stop to stop tuning the Q Exactive GC.

Help Displays the Help for this window.
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Mass Traces Window

Use the Mass Traces window to display mass traces for the total ion 
current and up to five m/z values in the Analysis Graphs window. See 
Figure 4-6. You can plot mass traces when manually adjusting source 
parameters such as gas flows. You can also optimize the collision energy.

NOTICE Make sure to tune your instrument for both ion modes if you 
want to use a switching method! Settings for both polarity modes are 
saved in the same tune file! ▲

The Mass Traces window has the following parameters:

Figure 4-6. Mass Traces window

Parameter Description

Plot

TIC Select this check box to plot the total ion current.

Masses to plot Select a check box for each m/z value that you want to plot (up to five). When 
you select a check box, the spin box becomes active. The spin box displays the 
mass-to-charge ratio to plot. You can set the mass-to-charge ratio to any value 
from m/z 30 to m/z 3000.

To change this value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. Alternatively, enter a value in the spin box 
text field.

Scan CE Select this option button to optimize the collision energy on the total ion 
current.



Explore Q Exactive GC Tune
Tasks Panel

Thermo Scientific Q Exactive GC Software Manual (P/N 1R120706-0003, Revision B) 4-21

Calibrate Window

Use the Calibrate window of the tasks panel to perform an automatic 
optimization of the calibration parameters. See Figure 4-7. Calibration 
parameters are instrument parameters whose values do not vary with the 
type of experiment.

Standard users can choose the ion mode they want to calibrate in the 
Calmix Calibration window. Advanced users can use the Calmix 
Calibration window to calibrate the instrument with the standard 
calibration gas. Alternatively, they can use the Customized Calibration 
window to enter parameters for a calibration with ions of their choosing.

NOTICE If the system was in Off mode before, it is necessary to put the 
instrument into On mode for at least 90 minutes before a mass 
calibration is performed. ▲

The calibrating procedure requires that you introduce calibration gas 
into the mass spectrometer at a steady rate.

The Calibrate window has the following parameters:

Just plot Select this option button to plot the mass trace without optimization.
Buttons

Start Click Start to start plotting the mass traces. The instrument needs to be in On 
status to start a plotting procedure.

When plotting is in progress, the Q Exactive GC Tune displays Stop.

Stop Click Stop to stop plotting the mass traces.

Help Displays the Help for this window.

Parameter Description

Figure 4-7. Calibrate window

Parameter Description

Progress bar Displays the elapsed percentage of the current 
calibration procedure.

Buttons
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❖ To display this window

Click  in the tasks panel.

Calmix Calibration Window

Use the Calmix Calibration window to select parameters and ion modes 
when performing an automatic calibration. See Figure 4-8 and 
Figure 4-9. The window displays the current statuses of the individual 
calibration items on the right side.

NOTICE Select MS Mass Calibration (pos) for daily calibration in EI 
mode.

Calibrate Click Calibrate to start an automatic 
calibration of the mass spectrometer. The 
instrument needs to be in On status to start a 
calibration. The duration of the automatic 
calibration depends on the selected check 
boxes; a complete automatic calibration 
requires about four minutes.

When calibration is in progress, 
Q Exactive GC Tune displays Stop.

Stop Click Stop to stop a calibration in progress.

Help Displays the Help for this window.

Parameter Description

Figure 4-8. Calmix Calibration window (for standard users)

Figure 4-9. Calmix Calibration window (for advanced users)



Explore Q Exactive GC Tune
Tasks Panel

Thermo Scientific Q Exactive GC Software Manual (P/N 1R120706-0003, Revision B) 4-23

The Calmix Calibration window has the following parameters:

Parameter Description

Base Calibration The Base Calibration item displays a hierarchical list of items in a tree view. 
Here, you can select individual parameters that you want to calibrate. 
If a check box is not selected, no subentry is selected. If the check box is 
selected, all subentries are selected. If the check box is filled, some subentries 
are selected.

This parameter is not available for standard users.

Isolation Mass and Res. (pos)
Isolation Mass and Res. (neg)

Select this check box to perform an automatic calibration for isolation mass 
and resolution of the quadrupole in the respective ion mode.

In a hierarchical list of items in a tree view, advanced users can select 
individual parameters that they want to calibrate. 
If the check box is not selected, no subentry is selected. If the check box is 
selected, all subentries are selected. If the check box is filled, some subentries 
are selected.

MS Mass Calibration (pos) Select this check box to perform an automatic calibration for all calibration 
parameters in the positive ion mode.

Use methane reagent gas for positive ion calibration in CI mode.. Refer to 
the Q Exactive GC Operating Manual for information.

MS Mass Calibration (neg) Select this check box to perform an automatic calibration for all calibration 
parameters in the negative ion mode.

Use negative ion chemical ionization for calibrations in negative mode. 
Methane is recommended as the optimal reagent gas for automated 
calibrations and evaluations. Refer to the Q Exactive GC Operating Manual 
for information.
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Customized Calibration Window

Use the Customized Calibration window to perform a mass calibration 
with user-defined ions. Enter the m/z values on which to calibrate. See 
Figure 4-10. This window is not available for standard users.

NOTICE Use this window for (positive and negative) mass calibration 
only! For all other calibration procedures, use the standard calibration 
ions! ▲

Figure 4-10. Customized Calibration window
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The Customized Calibration window has the following parameters:

Managing Mass Calibrations

If you want to disable a calibration from the Tune software, do the 
following. 

First, go to Instrument > Control > Mass Calibration Data > Higher 
Order Shape, right click the Spec. shape[x] cell with the values you no 
longer want to use and select Disable This Set. See Figure 4-11.

Parameter Description

Masses to calibrate Select a check box for each m/z value that you 
want to plot (up to ten for each ion mode). 
When you select a check box, the spin box 
becomes active. The spin box displays the 
mass-to-charge ratio to plot. You can set the 
mass-to-charge ratio to any value from m/z 30 
to m/z 3000.

To change this value, click the arrows in the 
spin box to increment [up arrow] or decrement 
[down arrow] the value. Alternatively, enter a 
value in the spin box text field.

Figure 4-11. Disabling Spectral Values
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The calibration is now disabled in the software. The disabled set of 
calibration points is no longer used to assign mass to measured ion 
frequencies. See Figure 4-12.

To remove older calibrations from the software, right click on the 
disabled Spec. shape[x] cell, and choose Remove All but Last 
Calibration. See Figure 4-13.

Figure 4-12. Disabling Spectral Values
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The older calibrations no longer appear in the tune software. See 
Figure 4-14.

Run a mass calibration with older values removed to store the change in 
the software.

Figure 4-13. Removing Older Calibrations

Figure 4-14. Tune Software with Older Calibrations Removed
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High Mass Calibration

To manually add high mass points to your Calibration in Tune, first tun 
an injection with a compound or compounds containing the high mass 
points you want add to your calibration.

Next, go to Advanced user setting in Tune and set Instrument > 
Settings > EI/CI Ion Source > Manual High Mass Calibration and set 
Include with Mass Calibration to Yes. See Figure 4-15.

In the Instrument Status panel, go to Instrument > Settings > EI/CI 
Ion Source > Positive (or Negative) Mass List and enter the theoretical 
and observed masses for each acquired compound. See Figure 4-16.

Figure 4-15. Enabling Manual High Mass Calibration

Figure 4-16. Entering Theoretical and Observed Masses
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Run the mass calibration as usual. Check the calibration report to ensure 
that the high masses were added. See Figure 4-17.

If you want to run a calibration without the high mass values, but want 
to save the values in the software, go to Instrument > Settings > EI/CI 
Ion Source > Manual High Mass Calibration and set Include with 
Mass Calibration to No. See Figure 4-18.

Figure 4-17. Calibration Report with High Masses Added

Figure 4-18. Calibration Report with High Masses Added



Explore Q Exactive GC Tune
Tasks Panel

4-30 Q Exactive GC Software Manual (P/N 1R120706-0003, Revision B) Thermo Scientific

Evaluate Window

Use the Evaluate window of the tasks panel to perform an automatic 
check of the instrument calibration. See Figure 4-19.

To enable an evaluation, standard users must select at least one check 
box in the Calmix Evaluation window. Advanced users must select at 
least one check box either in the Calmix Evaluation window or in the 
Customized Evaluation window.

The evaluation procedure requires that you introduce calibration gas 
into the mass spectrometer for at least 30 seconds. The filament must be 
on before starting the evaluation procedure.

The Evaluate window has the following parameters:

Figure 4-19. Evaluate window

Parameter Description

Progress bar Displays the elapsed percentage of the 
current evaluation procedure.

Buttons

Evaluate Click Evaluate to start an automatic 
evaluation of calibration parameters. 
The instrument needs to be in On 
status to start an evaluation.

When evaluation is in progress, 
Q Exactive GC Tune displays Stop.

Stop Click Stop to stop an evaluation in 
progress.

Help Displays the Help for this window.
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Calmix Evaluation Window

Use the Calmix Evaluation window to enable the evaluation with the 
standard calibration gas ions.

The Calmix Evaluation window has the following parameters:

Figure 4-20. Calmix Evaluation window (for advanced users)

Parameter Description

In a hierarchical list of items in a tree view, you can select individual parameters that you want to evaluate. 
If the check box is not selected, no subentry is selected. If the check box is selected, all subentries are selected. 
If the check box is filled, some subentries are selected.
Positive Ion Evaluation / Negative Ion Evaluation

Select the check boxes to evaluate various parameters for the respective ion mode.

-Base Evaluation Evaluates the basic performance of the instrument.

-Isolation Evaluation Evaluates the performance of the quadrupole.
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--Iso Mass/Res. Eval. Evaluates the instrument performance for quadrupole isolation and 
resolution.

This parameter is not available for standard users.

--Q Transmission Evaluation Evaluates the quadrupole transmission against minimum 
requirements. This evaluation requires a calibrated quadrupole and a 
stable calibration gas signal.

This parameter is not available for standard users.

--Quadrupole Isolations Shape Check Evaluates the quadrupole isolation window for different isolation 
widths. 

This parameter is not available for standard users.

-MS Mass Check Evaluates the m/z accuracy of the Orbitrap analyzer.

-Leak Check Evaluates the oxygen detected in background relative to oxygen 
introduced with the calibration gas reference leak.

-EI Tune Report Scans positive EI calibrant ions using the current tune parameters and 
makes a report. The EI Tune Report may be opened and viewed from 
the Reports menu.

-Evacuate Vacuum Inlet Evacuates the vacuum interlock for 30 seconds.
Extra Evaluation

Select the check boxes to evaluate various parameters that are not contained in the standard evaluations.

Electronics Evaluates the performance of electronic components.

-Quadrupole RF Frequency Checks the quadrupole RF voltage.

This parameter is not available for standard users.

-Inject Flatapole RF Checks the inject flatapole RF voltage.

This parameter is not available for standard users.

-Bent Flatapole RF Checks the bent flatapole RF voltage.

This parameter is not available for standard users.

-HCD RF Checks the RF voltage of the collision cell.

This parameter is not available for standard users.

Long-term Mass Accuracy Test Performs a mass accuracy test over an extended period.

This parameter is not available for standard users.

Isolation Transmission Endurance 
Test

Tests the behavior of the mass isolation optic elements under 
permanent ion load. The procedure requires a stable calibration gas 
signal with TIC > 5.0E+07; it will run for about 16 minutes.

This parameter is not available for standard users.

Parameter Description
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Customized Evaluation Window

Use the Customized Evaluation window to enter the m/z values on 
which to evaluate by using a user-defined calibrant. This window is not 
available for standard users.

NOTICE Not all calibrations or evaluations will use this customized 
list. ▲

Figure 4-21. Customized Evaluation window
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The Customized Evaluation window has the following parameters:

❖ To display this window

Click  in the Tasks window.

Parameter Description

Masses to evaluate Select a check box for each m/z value that you 
want to plot (up to ten for each ion mode). 
When you select a check box, the spin box 
becomes active. The spin box displays the 
mass-to-charge ratio to plot. You can set the 
mass-to-charge ratio to any value from m/z 30 
to m/z 3000.

To change this value, click the arrows in the 
spin box to increment [up arrow] or decrement 
[down arrow] the value. Alternatively, enter a 
value in the spin box text field.

Duration The spin box displays the duration (in minutes) 
of the evaluation procedure. You can set the 
duration to any value from 0.2 to 
2160 minutes. The default duration is 
0.5 minutes.

To change this value, click the arrows in the 
spin box to increment [up arrow] or decrement 
[down arrow] the value. Alternatively, enter a 
value in the spin box text field.
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Vacuum / Bakeout Window

The Vacuum / Bakeout window of the tasks panel reads back the 
pressure values at the vacuum gauges and allows performing an 
instrument bakeout.

NOTICE After the bakeout time has expired, the instrument requires a 
cooling and stabilization time of about three hours. ▲

The Vacuum / Bakeout window has the following parameters:

Figure 4-22. Vacuum / Bakeout window

Parameter Description

Vacuum

Green LEDs indicate that the readback values are sufficient for operating the Q Exactive GC mass 
spectrometer. If an LED indicates a vacuum problem, use the instrument status window for error diagnosis.

Fore vacuum This readback displays the actual pressure (in mbar) in the forevacuum line 
and ion source region as read by the Pirani gauge.

UHV This readback displays the actual pressure (in mbar) in the Orbitrap chamber 
as read by the ion gauge.

Bakeout

Bakeout time Enter the desired baking duration (in hours) into the spin box. The range is 4 
to 100 hours. When you click Bake out, the mass spectrometer starts the 
baking routine.

The baking script is stopped after the preset duration. Click Stop to abort the 
baking routine.

NOTICE The instrument has to cool down for another three hours before it 
can be used. ▲

Enter standby after Bakeout Select the check box to set the instrument to standby mode after the bakeout 
procedure is finished.

Progress bar Displays the elapsed percentage of the current baking procedure.
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❖ To display this window

Click  in the tasks 

panel.

Bake out Click Bake out to start the bakeout routine. To stop a bakeout in progress, 
click the Stop button.

NOTICE Bakeout is possible only when the instrument status is Off. ▲

Stop Click Stop to abort the bakeout routine. 

NOTICE The instrument has to cool down for another three hours before it 
can be used. ▲

Help Displays the Help for this window.

Parameter Description
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Display Panel
The windows in the display panel provide real-time information about 
the instrument status, the Q Exactive GC Tune software, or other 
programs.

The following windows are available:

• Spectrum Window

• Instrument Status Window

• Messages Window

• Analysis Graphs Window

• Debug Messages Window

The spectrum window is always visible. The debug messages window is 
not available for standard users.

Depending on the individual configuration of your system, additional 
windows may allow controlling other installed instruments.

Q Exactive GC Tune offers various ways to arrange windows in the 
display panel:

❖ To display a window in the display panel

Choose the respective command in the Windows menu.

❖ To hide a window in the display panel

• Choose the respective command in the Windows menu.

• Right-click the title bar of a window to display the shortcut menu. 
Choose Hide.

❖ To change the position of a window in the display panel

• Use the mouse to drag the window by its title bar to the new 
location, which can be even outside the Q Exactive GC Tune 
window.

• Within the display panel, you can dock the window to any one of 
the four sides. While you drag the window, Q Exactive GC Tune 
displays icons to indicate the available docking positions.

• Right-click the title bar of a docked window to display the shortcut 
menu. Choose Floating to undock the window. 

Alternatively, double-click on the title bar of the window.
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• Right-click the title bar of an undocked window to display the 
shortcut menu. Choose Floating to dock the window to its last 
docking position.

Alternatively, double-click the title bar of the window.

Spectrum Window

The spectrum window displays real-time data generated during 
calibration, tuning, and diagnostic tests. See Figure 4-23. The spectrum 
window is always visible.

The spectrum window allows using the mouse for zooming.

❖ To zoom in or out on a spectrum

• Click and drag with the left mouse button (hand cursor) from 
the beginning to the end of the portion you want to see 
enlarged.

• Alternatively, use the mouse wheel for zooming. Position the 
mouse pointer within the spectrum and roll the wheel forward 
to zoom in on the spectrum area. 

• To zoom in on the spectrum with respect to one axis only, 
position the mouse pointer within the axis area and roll the 
mouse wheel forward. Roll the wheel backward to zoom out.

Figure 4-23. Spectrum window
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• To increase the zooming factor by two, keep the <Shift> key 
pressed while using the mouse wheel.

To return to a display of the full spectrum, click the  button in 
the toolbar or choose Unzoom in the shortcut menu.

Press the <Shift> key to enable mouse panning. When mouse panning 
is active (mouse pointer changes to hand cursor), you can shift the 
spectrum along the X-axis while keeping the left mouse button pressed.

The spectrum window has the following parameters:

❖ To display this window

Choose Windows > Spectrum.

Toolbar

Use the buttons in the toolbar to manipulate the spectrum display.

Parameter Description 

Header

Scan # The number of scans since the beginning of the 
last acquisition (or since the last time the mass 
spectrometer was rebooted)

μS Number of microscans

IT Inject time (in milliseconds)

NL Normalization level

Type Scan type

The scan type information comprises ion 
polarity, source type, fragmentation type and 
energy (if active), and scan range. When the 
acquisition is controlled by an instrument 
method, the information includes the current 
scan segment and the current scan event.
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The toolbar of the spectrum window has the following parameters:

Parameter Description

Click to copy the current spectrum into the clipboard.

Click to plot the current spectrum.

You can view a print preview before the spectrum is 
printed. In a Page Setup dialog box, you can set up 
printer’s parameters (paper size and orientation, for 
example). 

Click to zoom in on the Y-axis (factor 2).

Click to zoom out on the Y-axis (factor 2).

Click to normalize the Y scale: Q Exactive GC Tune 
always displays the largest peak in the spectrum at full 
scale (vertical scale = largest peak in spectrum).

Click to zoom in on the X-axis (factor 2).

Click to zoom out on the X-axis (factor 2).

Click to display the entire mass range.

Click to normalize the display (X-axis, Y-axis).

Click to set to fixed mode: the height of the Y-axis is set 
equal to the height of the largest peak in the current 
spectrum and remains fixed even if larger peaks occur.

Click to set the Y-axis to the height of the highest peak so 
that the largest peak in the spectrum is always displayed 
at full scale.

Click to set to creep mode: the Y scale of the mass 
spectrum automatically increases if the peak intensity 
increases, but does not decrease if the peak intensity 
decreases.

Click to toggle between mouse panning and mouse 
zooming:
• When mouse panning is active, you can shift the 

spectrum along the X-axis while keeping the left 
mouse button pressed (hand cursor). 

• When mouse zooming is active, you can zoom in the 
spectrum by using the mouse.
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Shortcut Menu

Right-click the spectrum window to display the shortcut menu. It has 
the following commands:

Instrument Status Window

The instrument status window displays real-time status information for 
the instrument components. All parameters are arranged in a tree view. 
See Figure 4-24. The Control node is not available for standard users.

In addition to showing numerical values of parameters, the instrument 
status window uses icons to indicate the statuses of system components. 
Thus, you can use the instrument status window for a quick error 
diagnosis.

When expanded, some nodes provide shortcut menus that are displayed 
when you right-click an item. The available commands depend on the 
selected node and the user privileges. Generally, the shortcut menus 
allow changing the current settings.

Command Description 

Save Image As Saves the current graph as image file. A Save As 
dialog opens and you can enter the file name, 
file type, and the directory. 

Unzoom Reverts the zoom action.

Display options Opens the Display Options dialog box.

Figure 4-24. Instrument status window
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NOTICE For normal operation, it is not necessary to change the settings 
in the instrument status window. It just allows monitoring the system in 
more detail (more readbacks, etc.) than the other windows. ▲

❖ To display this window

Choose Windows > Instrument Status.

Messages Window

The messages window displays real-time information about the statuses 
of the instrument, the control service, or other programs. For further 
analysis, you can copy the content of the messages window to a text 
editor.

❖ To copy content from the messages window to a text editor

1. Select part of the content with the mouse, or
press <Ctrl> + <A> to select the complete content of the messages 
window.

2. Press <Ctrl> + <C> to copy the text to the clipboard.

3. Open a document in the text editor.

4. Press <Ctrl> + <V> to insert the copied text into the document.

The messages window has the following parameters:

Parameter Description

The messages are sorted with respect to time. To change the sort order, 
click the respective table column header. To invert the sort order, click 
again.

Priority The message priority is indicated by symbols:

Info; status is normal / command successful

Warning; no user action required

Error; user action required

Fatal error; program cannot proceed

Source The message source is indicated by symbols:

Message from Q Exactive GC Tune program

Message from instrument

Message from service
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❖ To display this window

Choose Windows > Messages.

Analysis Graphs Window

The analysis graphs window displays real-time data generated during 
calibration, tuning, and diagnostic tests. See Figure 4-25. To save data 
displayed in the window, choose Save Image As in the shortcut menu of 
the window.

The analysis graphs window allows using the mouse for zooming.

❖ To zoom in or out on an analysis graph

• Click and drag with the left mouse button (hand cursor) from 
the beginning to the end of the portion you want to see 
enlarged.

• Alternatively, use the mouse wheel for zooming. Position the 
mouse pointer within the graph and roll the wheel forward to 
zoom in on the graph area.

• To zoom in on the graph with respect to one axis only, position 
the mouse pointer within the axis area and roll the mouse wheel 
forward. Roll the wheel backward to zoom out.

• To increase the zooming factor by two, keep the <Shift> key 
pressed while using the mouse wheel.

Time Time and date of the message

Description Displays the message text.

Parameter Description

Figure 4-25. Analysis Graphs window
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To return to a display of the full spectrum, click the  button in 
the toolbar or choose Unzoom in the shortcut menu.

Press the <Shift> key to enable mouse panning. When mouse panning 
is active (mouse pointer changes to hand cursor), you can shift the graph 
along both axes while keeping the left mouse button pressed.

❖ To display this window

Choose Windows > Analysis Graphs.

Toolbar

The toolbar of the analysis graphs window has the following parameters:

Shortcut Menu

Right-clicking on the analysis graphs window displays the shortcut 
menu. It has the following commands:

Debug Messages Window

The debug messages window displays messages that can be used during 
method development. The debug messages window is not available for 
standard users. For further analysis, you can copy the content of the 
debug messages window to a text editor.

Parameter Description

Click to copy the current graph into the clipboard.

Click to plot the current graph.

You can view a print preview before the graph is printed. 
In a Page Setup dialog box, you can set up printer’s 
parameters (paper size and orientation, for example). 

Click to normalize the display (X-axis, Y-axis).

Command Description 

Save Image As Saves the current graph as image file. A Save As 
dialog opens and you can enter the file name, 
file type, and the directory.

Unzoom Reverts the zoom action.
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❖ To copy content from the debug messages window to a text editor

1. Select part of the content with the mouse, or
press <Ctrl> + <A> to select the complete content of the messages 
window.

2. Press <Ctrl> + <C> to copy the text to the clipboard.

3. Open a document in the text editor.

4. Press <Ctrl> + <V> to insert the copied text into the document.

The debug messages window has the following parameters:

❖ To display this window

Choose Windows > Debug Messages.

Shortcut Menu of the Debug Messages Window

The debug messages window has a shortcut menu that is displayed when 
you right-click into the window. Use the commands of the shortcut 
menu to configure the scope of the messages displayed in the window. 
Click a command to activate it; click it again to deactivate it.

The following message priorities can be displayed:

• Debug

Parameter Description

The messages are sorted with respect to time. To change the sort order, 
click the respective table column header. To invert the sort order, click 
again.

Priority The message priority is indicated by symbols:

Debugging message

Info; status is normal / command successful

Warning; no user action required

Error; user action required
 Fatal error; program cannot proceed

Source The message source is indicated by symbols:

Message from Q Exactive GC Tune program.

Message from instrument.

Message from service.

Time Time and date of the message

Description Displays the message text.
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• Log

• Info

• Warning

• Error

• Fatal

For each message priority, the following message sources are available:

• Instrument

• Service

• Application

A  icon in front of a message source shows that it is selected. A  
icon in front of a message priority shows that it is shown for all three 
message sources. A  icon in front of a message priority shows that it 
is shown for one or two message sources.

In addition to the commands for configuring the content of the debug 
messages window, the Clear list command allows removing the 
complete content of the window.
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Dialog Boxes
This section provides a reference to the dialog boxes in Q Exactive GC 
Tune.

Dialog Boxes Displayed from the Menu Bar

• About Dialog Box

• License Dialog Box

• Mass Calculator

Dialog Boxes Displayed from the Toolbar

• Scan Parameters History Dialog Box

Dialog Boxes Displayed from the Scan Parameters Window

• Fragmentation Dialog Box

• Scan Parameters History Dialog Box

• Scan Range Dialog Box

• Scan Type Dialog Box

Dialog Boxes for Editing Lock Masses

• Collection Modification Dialog Box

• Delete Lock Mass Collection Dialog Box

• Lock Masses Dialog Box

• Lock Mass Removal Dialog Box

• Lock Mass Replacement Dialog Box

• Name Change Dialog Box

• New Lock Mass Collection Dialog Box

Dialog Boxes Displayed from the Spectrum Window

• Display Options Dialog Box
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About Dialog Box

Use the About dialog box to display information about the instrument, 
the current Q Exactive GC Tune version, and the active licenses. See 
Figure 4-26. To copy the instrument identification to the clipboard, 
click the  button.

The About dialog box has the following parameters:

❖ To display this dialog box

Choose Help > About.

Figure 4-26. About dialog box

Parameter Description

Buttons

OK Saves your changes and closes the dialog box.

Add license Displays the License dialog box.

Back / Next Display various dialog boxes with legal 
information and information about third party 
licenses used by Q Exactive GC Tune.

Help Displays the Help for this dialog box.
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License Dialog Box

Use the License dialog box to enter licenses that activate additional 
features. See Figure 4-27.

NOTICE This feature is used by a qualified Thermo Fisher Scientific 
engineer for service. ▲

The License dialog box has the following parameters:

❖ To display this dialog box

1. Choose Help > About to display the About dialog box.

2. In the About dialog box, click Add license.

Figure 4-27. License dialog box

Parameter Description

License key Use the text box to enter the license key.
Buttons

OK Saves your changes and closes the dialog box.

Cancel Discards your changes and closes the dialog box.

Help Displays the Help for this dialog box.



Explore Q Exactive GC Tune
Dialog Boxes

4-50 Q Exactive GC Software Manual (P/N 1R120706-0003, Revision B) Thermo Scientific

Mass Calculator

Use the Mass Calculator to calculate the exact mass of an compound of 
interest.

The Mass Calculator has the following parameters:

Figure 4-28. Mass Calculator (Tune)

Parameter Description

Compound

Formula Use the text field to specify the basic composition of the compound. Click the 
down arrow to display a list of the last entered compounds.

The syntax rules and interpretation accept the kind of formula that is also 
accepted on the Spectrum Simulation page (Isotope Simulation area) of the 
Qual Browser.

Type Use the Type list to specify the formula type used in the Formula field:
• Chemical formula Formula is defined as the resulting elemental 

composition of the entered formula. This is the default selection.

Independent of the entry in the Species field, the elemental composition and the 
mass of the compound, Formula is completely determined by the given formula 
and selected formula type.
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❖ To display the Mass Calculator

Choose Windows > Mass Calculator.

Scan Parameters History Dialog Box

Use the Scan Parameters History dialog box to select from a list of recent 
scans based on short scan descriptions. See Figure 4-29. Select a scan 
from the list to populate all scan parameters in the Scan Parameters 
window with the parameters from that scan.

Species Use this text field to define adducts or modifications of the active compound 
that are expected to be formed.

The Species field can be used in two ways:

• Click the down arrow to display a list of predefined adducts for each 
polarity:

- +H, +NH4, +C2H5, +C3H5, +C4H9 for positive polarity

- -H for negative polarity

- an empty entry to express adducts (for example, radical cations) for both 
polarities.

The corresponding set will be displayed depending on the selected polarity. 

Selecting an adduct (A) will result in the strict behavior of applying one unit 
A to the compound and using “+H” or “-H” adduct depending on the 
charge state and active polarity.

• Enter the modifications of the compound by using squared brackets and at 
least M as representation of the basic compound. The predefined adducts 
can be entered, too. This definition is used without additional auto 
dependencies, like adding protons. 

Charge state Use the list box to select the resulting charge state. Available options are 1+ to 
25+ for positive polarity and 1– to 25– for negative polarity. The default charge 
state is 1+ for positive polarity and 1– for negative polarity.

Polarity Use the option buttons to select the applied polarity. The default polarity is 
positive.

m/z This text field displays the calculated mass-to-charge ratio, with five decimal 
places (for example, 524.26496).

Composition This text field displays the determined total formula (for example, C23 H38 N7 
O5 S).

Parameter Description
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If the Hot link check box is selected in the Scan Parameters window, 
selecting another list item immediately changes the instrument 
parameters.

❖ To display this dialog box

In the Scan Parameters window, click the History field.

Scan Type Dialog Box

Use the Scan Type dialog box to select the scan type to be used during 
the currently selected scan event. See Figure 4-30.

Figure 4-29. Scan Parameters History dialog box

Figure 4-30. Tune—Scan Type dialog box
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The Scan Type dialog box has the following parameters:

❖ To display this dialog box

In the Scan Parameters window, click the Scan type field.

Parameter Description

AIF - MS/MS Select this option button to enable a Full MS scan (isolation width > 10 amu) or a 
selected ion monitoring (isolation width 10 amu) scan type.

NOTICE For Full MS – SIM experiments, set the scan options in the Scan Range 
dialog box.

Isolation

Use the Isolation area to set the scan range of the selected scan type.

Minimum Use this spin box to select the minimum value for the scan range (in mass-to-charge 
ratio units) used during the currently selected scan event.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. You can enter any value from 30.0 to 2500.

Maximum Use this spin box to select the maximum value for the scan range (in mass-to-charge 
ratio units) used during the currently selected scan event.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. You can enter any value from 30.4 to 3000.0.

Center Use this spin box to select the center mass (in mass-to-charge ratio units) of the 
scan range. When the isolation width is < 50, the software considers 
Center = Precursor.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. You can enter any value from 30.2 to 2750.0.

Precursor Use this spin box to select the mass of a precursor ion of interest.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. You can enter any value from m/z 30.2 to 4250.

Width Use this spin box to select either the width of the scan range (in mass-to-charge 
ratio units) used for a SIM scan or the isolation width for the precursor ion of 
interest during an MS/MS scan.

To change the value, click the arrows in the spin box to increment [up arrow] or 
decrement [down arrow] the value. 

For Full MS scans, you can enter any value from m/z 0.4 to 2800.0. For SIM and 
MS/MS scans, you can enter any value from m/z 0.4 to 10.
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Scan Range Dialog Box

Use the Scan range dialog box to specify the scan range of the data 
acquisition. See Figure 4-31. The scan range affects the amount of 
stored and transmitted data.

The Scan Range dialog box allows setting either minimum and 
maximum or center and width of the scan range. If you change one pair 
of values, the other pair is changed accordingly. 

NOTICE The ratio for maximum-to-minimum should not exceed 15. If 
necessary, Q Exactive GC Tune will correct the settings automatically. ▲

The Scan range dialog box has the following parameters:

Figure 4-31. Scan range dialog box

Parameter Description

Minimum Use this spin box to select the minimum value for the 
scan range (in mass-to-charge ratio units) used during 
the currently selected scan event.

To change the value, click the arrows in the spin box 
to increment [up arrow] or decrement [down arrow] 
the value. You can enter any value from 30.0 to 
2500.0.

NOTICE Scanning below 50 m/z might reduce 
instrument performance. ▲

Maximum Use this spin box to select the maximum value for the 
scan range (in mass-to-charge ratio units) used during 
the currently selected scan event.

To change the value, click the arrows in the spin box 
to increment [up arrow] or decrement [down arrow] 
the value. You can enter any value from 30.4 to 
3000.0.
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❖ To display this dialog box

In the Scan Parameters window, click the Scan range field.

Fragmentation Dialog Box

Use the Fragmentation dialog box to activate a fragmentation with the 
HCD collision cell. You can specify the fragmentation voltages to be 
used. See Figure 4-32.

The Fragmentation dialog box has the following parameters:

Center Use this spin box to select the center mass (in 
mass-to-charge ratio units) of the scan range.

To change the value, click the arrows in the spin box 
to increment [up arrow] or decrement [down arrow] 
the value. You can enter any value from 30.2 to 
2750.0.

Width Use this spin box to select the width of the scan range 
(in mass-to-charge ratio units) used during the 
currently selected scan event.

To change the value, click the arrows in the spin box 
to increment [up arrow] or decrement [down arrow] 
the value. You can enter any value from 0.4 to 
2800.0.

Parameter Description

Figure 4-32. Tune—Fragmentation dialog box

Parameter Description

HCD

Activates the HCD collision cell. When you select this check box, Q Exactive GC Tune automatically 
changes the scan type, if necessary.

NOTICE When HCD fragmentation is on, automatic tuning comprises only HCD relevant parameters. ▲

CE Use this box to select the collision energy for the HCD fragmentation. To change the 
value, click the arrows in the spin box to increment [up arrow] or decrement [down arrow] 
the value. You can enter any value from 10 to 200.
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❖ To display this dialog box

In the Scan Parameters window, click into the Fragmentation field.

Collection Modification Dialog Box

Use this dialog box to modify a lock mass collection by importing lock 
masses from an xml file See Figure 4-35. This dialog box appears only 
when the xml file contains information about lock mass collections that 
differs from the available lock mass collections.

The Collection Modification dialog box has the following parameters:

❖ To display this dialog box

1. Choose Import > Merge with file content in the shortcut menu of 
the Lock Masses dialog box.

2. In the file selection dialog box, select an xml file to import from.

Figure 4-33. Collection Modification dialog box

Parameter Description

OK Saves your changes and closes the dialog box. The lock 
mass collection is updated with the data contained in the 
xml file.

Cancel Discards your changes and closes the dialog box.

Help Displays the Help for this dialog box.
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Lock Masses Dialog Box

Use the Lock Masses dialog box to edit lock mass lists. See Figure 4-34. 
The table shows all available lock masses. Lock mass collections store 
information about lock mass usage.

The Lock Masses dialog box has the following parameters:

Figure 4-34. Tune—Lock Masses dialog box

Parameter Description

Lock mass lists

Lock mass lists Use the list box to select an existing lock mass collection.

Displays the New Lock Mass Collection dialog box where you can enter the 
name for a new lock mass collection.

Deletes the active lock mass collection. The lock masses themselves are still 
available.

This button is not available when no lock mass collection is selected.

Displays the Name Change dialog box where you can edit the name of the active 
lock mass collection.

This button is not available when no lock mass collection is selected.



Explore Q Exactive GC Tune
Dialog Boxes

4-58 Q Exactive GC Software Manual (P/N 1R120706-0003, Revision B) Thermo Scientific

❖ To display this dialog box

In the Scan Parameters window, click into the Lock Masses field.

Shortcut Menu of the Lock Masses dialog box

The Lock Masses dialog box has a shortcut menu that is displayed when 
you right-click into the dialog box. 

It has the following commands:

Available lock masses

The table displays the properties of the available lock masses and whether they are used in the 
selected lock mass collection. To change the sort order, click the respective table column header. To 
invert the sort order, click again.

Lock mass table • Use
Select the check box to use the lock mass. A  indicates that the lock mass 
is used in the active lock mass collection. The lock mass is displayed in the 
Lock masses field of the Scan Parameters window.

• Polarity
Click the symbol to change the polarity of the lock mass.

NOTICE During a scan, the Q Exactive GC mass spectrometer uses only the 
lock masses with a polarity that matches the active ion mode. ▲

• m/z
Enter the mass of the lock mass into the field (with a maximum of five 
decimals).

• Comment
Enter a comment for the lock mass into the field. This field is optional.

Creates a new lock mass.

Deletes the selected lock masses.

Parameter Description

Command Description 

Select all masses in use Selects all masses used in the active lock mass collection.

This command is not available when no lock mass is used.

Import > Merge with clipboard Appends the content of the clipboard to the available lock masses.

NOTICE The clipboard stores lock mass data as tabulator-separated text 
files. When the data in the clipboard are not in this format, the 
command is not available. ▲
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Import > Replace by clipboard Replaces the available lock masses by the content of the clipboard.

NOTICE The clipboard stores lock mass data as tabulator-separated text 
files. When the data in the clipboard are not in this format, the 
command is not available. ▲

Import > Merge with file content Opens a dialog box so that you can select a .csv, .txt, or .xml file that 
contains a list of lock masses. The content of the file is appended to the 
available lock masses.

See Exporting and Importing Lock Masses for information about the 
format of lock mass files.

Import > Replace by file content Opens a dialog box so that you can select a .csv, .txt, or .xml file that 
contains a list of lock masses. All available lock masses are replaced by 
the masses contained in the imported file. The present lock masses are 
removed from all existing lock mass lists. You have to confirm your 
action in the Lock mass replacement dialog box.

See Exporting and Importing Lock Masses for information about the 
format of lock mass files.

Export > Copy selected to clipboard Copies the data of the selected lock mass to the clipboard.

Export > Copy all to clipboard Copies the data of all available lock masses to the clipboard.

Export > Copy selected to file Opens the dialog box, where you can save the data of the selected lock 
mass(es) as a .csv, .txt, or .xml file.

See Exporting and Importing Lock Masses for information about the 
format of lock mass files.

Export > Copy all to file Opens the dialog box, where you can save the data of all available lock 
masses as a .csv, .txt, or .xml file.

See Exporting and Importing Lock Masses for information about the 
format of lock mass files.

Command Description 
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Lock Mass Removal Dialog Box

Use this dialog box to delete one or more lock masses that are selected in 
the Lock Masses dialog box. See Figure 4-35.

The Lock Mass Removal dialog box has the following parameters:

❖ To display this dialog box

In the Lock Masses dialog box, click the  button.

Lock Mass Replacement Dialog Box

Use this dialog box to replace all available lock masses by masses 
contained either in a csv, txt, or xml file or in the clipboard. See 
Figure 4-35.

Figure 4-35. Lock Mass Removal dialog box

Parameter Description

OK Saves your changes and closes the dialog box. The lock 
masses are now removed from the table in the Lock 
Masses dialog box.

Cancel Discards your changes and closes the dialog box.

Help Displays the Help for this dialog box.

Figure 4-36. Lock Mass Replacement dialog box
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The Lock Mass Replacement dialog box has the following parameters:

❖ To display this dialog box

Choose Import > Replace by file content or Import > Replace by 
clipboard in the shortcut menu of the Lock Masses dialog box.

New Lock Mass Collection Dialog Box

Use this dialog box to enter a name for the lock mass collection that is 
displayed in the Lock Masses dialog box. See Figure 4-37.

The New Lock Mass Collection dialog box has the following 
parameters:

Parameter Description

OK Removes the lock masses and replaces them by the 
imported lock masses. The present lock mass collections 
become void.

Cancel Closes the dialog box.

Help Displays the Help for this dialog box.

Figure 4-37. New Lock Mass Collection dialog box

Parameter Description

Name of lock mass 
collection

Use this text field to enter the name for the new 
lock mass collection.

Buttons

OK Saves your changes and closes the dialog box. 
The name of the lock mass collection is now 
displayed in the list box of the Lock Masses 
dialog box.

Cancel Discards your changes and closes the dialog box.

Help Displays the Help for this dialog box.
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❖ To display this dialog box

In the Lock Masses dialog box, click the  button.

Delete Lock Mass Collection Dialog Box

Use this dialog box to delete an existing lock mass collection. See 
Figure 4-38. The lock masses themselves are not deleted.

The Delete Lock Mass Collection dialog box has the following 
parameters:

❖ To display this dialog box

In the Lock Masses dialog box, click the  button.

Figure 4-38. Delete Lock Mass Collection dialog box

Parameter Description

OK Saves your changes and closes the dialog box. The name 
of the lock mass collection is now removed from the list 
box of the Lock Masses dialog box.

Cancel Discards your changes and closes the dialog box.

Help Displays the Help for this dialog box.
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Name Change Dialog Box

Use this dialog box to change the name of an existing lock mass 
collection. See Figure 4-39.

The Name Change dialog box has the following parameters:

❖ To display this dialog box

In the Lock Masses dialog box, click the  button.

Figure 4-39. Name Change Dialog Box

Parameter Description

Name of lock mass 
collection

Use this text field to enter the new name for the 
lock mass collection.

Buttons

OK Saves your changes and closes the dialog box. 
The name of the lock mass collection is now 
displayed in the list box of the Lock Masses 
dialog box.

Cancel Discards your changes and closes the dialog box.

Help Displays the Help for this dialog box.



Display Options Dialog Box

Use this dialog box to modify the appearance of the displayed mass 
spectrum in the spectrum window. See Figure 4-40.

The Display Options dialog box has the following parameters:

❖ To display this dialog box

In the shortcut menu of the spectrum window, choose Display 
options.

Figure 4-40. Display Options Dialog Box

Parameter Description

Decimal places for m/z Use this list box to set how many decimal 
places of precision are shown when mass 
positions are annotated on mass spectra. The 
valid range is 0 to 5.

Show resolution Select this check box to have Q Exactive GC 
Tune annotate mass peaks with the mass 
resolution. 

Show charge state Select this check box to have Q Exactive GC 
Tune annotate mass peaks with the charge 
state. 

Show flags Select this check box to have Q Exactive GC 
Tune indicate peaks that are contained in the 
active lock mass collection.

NOTICE The scan parameters window must 
show entries for lock masses. ▲

Buttons

OK Saves your changes and closes the dialog box.

Help Displays the Help for this dialog box.
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Tune Reports
To generate a tune report, select the EI Tune Report box in the Calmix 
Evaluation Window (see “Calmix Evaluation Window” on page 4-31). 
To view an EI tune report, in the top menu, go to Reports > EI Tune 
Report. See Figure 4-41.

Figure 4-41. EI Tune Report

NOTICE The accuracy and precision of the read values are not carefully 
controlled. The read values should be within approximately 1.3 V of the 
set value. If the read values are much different, have a qualified person 
check for a short in the wires supplying the ion source, such as wires 
touching the manifold or magnet yoke. ▲

NOTICE Shoulder peaks are part of the frequency signal measured from 
the Orbitrap and are labeled as exception peaks so they do not get 
processed as real peaks. If these shoulder peaks become too intense 
relative to the main peak, run the eFT parameter and MS mass 
calibrations. If this does not bring the shoulder peaks below 5%, the 
lenses admitting ions into the Orbitrap may need to be tuned by a 
qualified service person. ▲

Q Exactive GC Tune Report
Date of Tune Report: 2015-05-08 16:31:09
Instrument Identification: Exactive Series slot #MP-5 (001999C91DFD)
Software Version: 2.6-262803/2.6.0.2629
Data System User:
Tune File:

\
C:\Xcalibur\methods\EI_Positive.mstune

Ion Source Tune Settings
Parameter Set value Read value
Emission current (µA) 50.0 49.0
Electron lens voltage (V) 15.0 14.6
Filament voltage (V) -64.7 -64.8
Source offset voltage (V) 5.3 5.1
Repeller voltage (V) 7.7 7.5
Lens 1 voltage (V) -49.5 -48.9
Lens 2 voltage (V) -1.0 -1.4
Lens 3 voltage (V) -20.7 -20.5

Ion Transfer and Analyzer Injection Tune Settings
Parameter Set value Read value
Inter Flatapole Lens (V) 2.5 2.3
Injection Flatapole DC (V) 1.8 1.8
C-Trap Energy Offset (V) 0.0 N/A

Name:_____________________________________ Signature:_____________________________________ Date: ___________
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The relative intensities of ions displayed in the EI tune report vary 
according to the ions specified in the tune as well as the ion source 
temperature.

Q Exactive GC Tune Report
Date of Tune Report: 2015-05-08 16:31:09
Last Mass Calibration: 2015-05-08 16:25:12
Instrument Identification: Exactive Series slot #MP-5 (001999C91DFD)
Software Version: 2.6-262803/2.6.0.2629
Data System User:
Tune File:

\
C:\Xcalibur\methods\EI_Positive.mstune

m/z 68.99471 m/z 130.99155 m/z 218.98513 m/z 413.97727 m/z 501.97099
Intensity: 2.208e+08 Intensity: 6.607e+08 Intensity: 2.159e+08 Intensity: 4.148e+07 Intensity: 2.544e+07
Accuracy: 0.64 ppm Accuracy: 0.61 ppm Accuracy: 0.24 ppm Accuracy: 0.70 ppm Accuracy: 0.79 ppm
Resolution: 122,549 Resolution: 88,178 Resolution: 67,367 Resolution: 49,538 Resolution: 44,684

Scan Type Full MS
Scan range 50 to 550 m/z
Resolution @ m/z 200 60,000
AGC target 1,000,000
Microscans 10
Ionization mode EI
Polarity Positive
Electron energy 70 eV
Emission current 50 µA
Filament selection 2
Ion source temperature 200.0 °C
MS transfer line temperature 249.9 °C
Fore vacuum 3.69e-02 mbar
Ultra-high vacuum 5.36e-10 mbar

Theoretical Monoisotopic Peak Mass Accuracy Relative Abundance Theoretical Isotope Peak Mass Accuracy Isotope Ratio
(m/z) (ppm) (%) (m/z) (ppm) (%)

68.99466 0.64 33.42 69.99802 0.74 1.22
130.99147 0.61 100.00 131.99482 0.11 3.32
218.98508 0.24 32.67 219.98844 0.09 4.38
413.97698 0.70 6.28 414.98033 1.10 8.62
501.97059 0.79 3.85 502.97394 0.65 10.17

Last Leak Check: 2015-05-08 16:26:40, Leak check completed: 0.81%

Name:_____________________________________ Signature:_____________________________________ Date: ___________

Shoulder Peaks



Explore Q Exactive GC Tune
Tune Reports

Thermo Scientific Q Exactive GC Software Manual (P/N 1R120706-0003, Revision B) 4-67

Parameters of interest in the tune report are:

Parameter Description

m/z 219 The resolution should be above the value set 
in the tune file. The peak at m/z 219 will be 
low in intensity after venting the instrument 
or admitting moist atmospheric air into the 
nitrogen supply. Its intensity can indicate the 
trapping gas purity.

Accuracy If the instrument has been recently 
calibrated, this value should be < 1 ppm. I f 
accuracy is not < 3 ppm, a perform a mass 
calibration.

Ultra-high vacuum This value should be < 8e-10 mbar

Last leak check This parameter displays the results from the 
last date and time a leak check was run. 
Values should be less than 10%. If the result 
is over 10%, the software reports that the leak 
check failed. See the Q Exactive GC 
Operating Manual for troubleshooting 
information. If you cannot find a leak and 
the leak check remains higher than 10%, 
contact customer support.
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Chapter 5 Procedures in Q Exactive GC Tune

This chapter describes procedures that you may need when using 
Q Exactive GC Tune.

Contents

• Using Lock Masses and Lock Mass Collections

• Performing a System Bakeout

• Changing Default Settings of Q Exactive GC Tune
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Using Lock Masses and Lock Mass Collections
This section provides instructions for using lock masses and lock mass 
collections.

 The following topics are available:

• Adding a Lock Mass

• Deleting Lock Masses

• Exporting and Importing Lock Masses

• Creating a new Lock Mass Collection

• Renaming a Lock Mass Collection

• Adding a Lock Mass to a Lock Mass Collection

• Removing a Lock Mass from a Lock Mass Collection

• Deleting a Lock Mass Collection

Adding a Lock Mass

❖ To add a lock mass

1. In the Lock Masses dialog box, click the  button. A new row 
appears at the end of the lock mass table. See Figure 5-1.

2. Enter the data for the new lock mass into the new table row:

a. Select the Use check box if you want to use the new lock mass in
the active lock mass collection.

Figure 5-1. Adding a new lock mass
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b. Click the cell in the Polarity column until the correct sign 
appears:  for positive or  for negative.

c. Enter the m/z value for the new lock mass (with a maximum of 
five decimals).

d. Optionally, enter a comment for the new lock mass.

The new lock mass is now available to be used.

Deleting Lock Masses

❖ To delete lock masses

1. In the Lock Masses dialog box, select one lock mass or several lock 
masses:

• To select a single lock mass, click into the respective table row.

• To select adjacent lock masses, click the first table row. Then 
hold down the <Shift> key while you click the last row.

• To select nonadjacent lock masses, click the first table row. Then 
hold down the <Ctrl> key while you click the other rows that 
you want to add to the selection.

2. Click the  button. The Lock Mass Removal dialog box appears 
and requests your confirmation for deleting the listed lock masses.

3. Click OK to confirm your input and to close the dialog box. All 
selected lock masses are removed from the list in the Lock Masses 
dialog box.

Exporting and Importing Lock Masses

Q Exactive GC Tune allows exporting lock mass data to the clipboard or 
to a file. Other applications can then use the data. You can also copy the 
export files to other computers where Q Exactive GC Tune is installed. 
So you can reuse the lock masses without having to recreate them. To 
reuse the lock masses, import the data either from the clipboard or from 
a lock mass file.

With a spreadsheet, a text editor, or an XML editor, you can create lock 
mass files even without using Q Exactive GC Tune.

Lock Mass Files

Q Exactive GC Tune uses the following file formats for exporting and 
importing lock mass data:

• Comma-separated value lists (.csv)
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• Tabulator-separated text files (.txt)

• XML files (.xml)

Lock mass data are stored in the following order:

1. Usage status: True for used, False for unused

2. Ion polarity: positive mode or negative mode

3. m/z: up to five decimals

4. Comment: optional

The clipboard stores lock mass data as tabulator-separated text files. In 
contrast to . csv and .txt files, .xml files additionally store information 
about lock mass collections and lock mass usage.

Exporting Lock Masses

Q Exactive GC Tune allows exporting lock mass data to the clipboard or 
to a file.

❖ To export selected lock masses to the clipboard

1. In the Lock Masses dialog box, select the lock masses you want to 
export:

• To select a single lock mass, click into the respective table row.

• To select adjacent lock masses, click the first table row. Then 
hold down the <Shift> key while you click the last row.

• To select nonadjacent lock masses, click the first table row. Then 
hold down the <Ctrl> key while you click the other rows that 
you want to add to the selection.

2. Right-click into the dialog box to display the shortcut menu.

3. Choose Export > Copy selected to clipboard to copy the selected 
lock mass to the clipboard.

❖ To export all lock masses to the clipboard

1. In the Lock Masses dialog box, right-click into the dialog box to 
display the shortcut menu.

2. Choose Export > Copy all to clipboard to copy all available lock 
mass to the clipboard.

❖ To export some lock masses to a file

1. In the Lock Masses dialog box, select the lock masses you want to 
export:
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• To select a single lock mass, click into the respective table row.

• To select adjacent lock masses, click the first table row. Then 
hold down the <Shift> key while you click the last row.

• To select nonadjacent lock masses, click the first table row. Then 
hold down the <Ctrl> key while you click the other rows that 
you want to add to the selection.

2. Right-click into the dialog box to display the shortcut menu.

3. Choose Export > Copy selected to file to open the file selection 
dialog box. See Figure 5-2.

a. Browse to the destination of the export file.

b. Select the format of the export file.

c. Enter a new name for the export file or select an existing file.

d. Click Save to export the selected lock masses to the file. If you 
want to overwrite an existing file, you have to confirm your 
action in a dialog box. The file selection dialog box is closed.

Figure 5-2. Selecting the lock mass export file
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❖ To export all lock masses to a file

1. In the Lock Masses dialog box, right-click into the dialog box to 
display the shortcut menu.

2. Choose Export > Copy all to file to open the file selection dialog 
box. See Figure 5-3.

a. Browse to the destination of the export file.

b. Select the format of the export file.

c. Enter a new name for the export file or select an existing file.

d. Click Save to export the lock masses to the file. If you want to 
overwrite an existing file, you have to confirm your action in a 
dialog box. The file selection dialog box is closed.

Importing Lock Masses

Q Exactive GC Tune allows importing lock mass data from the 
clipboard or from a file. The imported lock masses either are added to 
the present lock masses or they replace them.

❖ To add lock masses from the clipboard

1. Copy lock mass data in an appropriate format to the clipboard. See 
Lock Mass Files for information about the requirements.

2. In the Lock Masses dialog box, right-click into the dialog box to 
display the shortcut menu.

3. Choose Import > Merge with clipboard to import the lock mass 
data from the clipboard to the lock mass table.

NOTICE The clipboard stores lock mass data as tabulator-separated text 
files. When the data in the clipboard are not in this format, the 
command is not available. ▲

Figure 5-3. Selecting the lock mass export file
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4. The lock mass list in the Lock Masses dialog box displays additional 
rows for the imported lock masses.

❖ To add lock masses from a file

1. In the Lock Masses dialog box, right-click into the dialog box to 
display the shortcut menu.

2. Choose Import > Merge with file content to open the file selection 
dialog box.

a. Browse to the destination of the import file.

b. Select the format of the import file.

c. Select one of the displayed files.

d. Click Open to import the lock masses to Q Exactive GC Tune. 
The dialog box is closed.

3. If you are importing an xml file that contains information about 
lock mass collections that differs from the present lock mass 
collections, the Collection modification dialog is displayed. Click 
OK to confirm the operation and to close the dialog box.The lock 
mass list in the Lock Masses dialog box displays additional rows for 
the imported lock masses.

❖ To replace all lock masses by clipboard data

1. Copy lock mass data in an appropriate format to the clipboard. See 
Lock Mass Files for information about the requirements.

2. In the Lock Masses dialog box, right-click into the dialog box to 
display the shortcut menu.

3. Choose Import > Replace by clipboard to import the lock mass 
data from the clipboard to the lock mass table.

NOTICE The clipboard stores lock mass data as tabulator-separated text 
files. When the data in the clipboard are not in this format, the 
command is not available. ▲

4. The Lock Mass Replacement dialog box is displayed. Click OK to 
confirm the import.

5. The Lock Mass Replacement dialog box is closed. The lock mass list 
in the Lock Masses dialog box displays only the imported lock 
masses.

❖ To replace all lock masses from a file

1. In the Lock Masses dialog box, right-click into the dialog box to 
display the shortcut menu.
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2. Choose Import > Replace by file content.

3. The Lock Mass Replacement dialog box is displayed. Click OK to 
confirm the import.The Lock Mass Replacement dialog box is 
closed. The file selection dialog box is displayed.

a. Browse to the destination of the import file.

b. Select the format of the import file.

c. Select one of the displayed files.

d. Click Open to import the lock masses to Q Exactive GC Tune. 
The dialog box is closed.

4. The lock mass list in the Lock Masses dialog box displays only the 
imported lock masses.

If you have imported lock mass data from an xml file that contained 
information about lock mass collections and lock mass usage, the 
dialog box displays the corresponding information.

Creating a new Lock Mass Collection

❖ To create a lock mass collection

1. In the Lock Masses dialog box, click the  button.

2. In the New Lock Mass Collection dialog box, enter a name for the 
new lock mass collection. See Figure 5-4.

3. Click OK to confirm your input and to close the dialog box.

4. The name of the new lock mass collection appears in the list box of 
the Lock Masses dialog box.

Figure 5-4. Creating a lock mass collection
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Renaming a Lock Mass Collection

❖ To rename a lock mass collection

1. In the Lock Masses dialog box, select an existing lock mass 
collection in the list box.

2. Click the  button. The Name Change dialog box is displayed. 
See Figure 5-5.

3. In the text field, replace the old name of the lock mass collection 
with the new name.

4. Click OK to confirm your input and to close the dialog box.

5. In the Lock Masses dialog box, the new lock mass collection is 
displayed in the list box.

Adding a Lock Mass to a Lock Mass Collection

❖ To add a lock mass to a lock mass collection

1. In the Lock Masses dialog box, select an existing lock mass 
collection in the list box.

2. Select the Use check box in the table row of the lock mass.

3. A  indicates that the lock mass is used in the active lock mass 
collection.

Removing a Lock Mass from a Lock Mass Collection

❖ To remove a lock mass from a lock mass collection

1. In the Lock Masses dialog box, select an existing lock mass 
collection in the list box.

2. Clear the Use check box in the table row of the lock mass.

Figure 5-5. Changing the name of a lock mass collection
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3. A  indicates that the lock mass is not used in the active lock mass 
collection.

Deleting a Lock Mass Collection

❖ To delete a lock mass collection

1. In the Lock Masses dialog box, select an existing lock mass 
collection in the list box.

2. Click the  button.

3. In the Delete Lock Mass Collection dialog box, click OK to confirm 
your action and to close the dialog box.

4. The name of the lock mass collection is removed from the list box of 
the Lock Masses dialog box.



Procedures in Q Exactive GC Tune
Performing a System Bakeout

Thermo Scientific Q Exactive GC Software Manual (P/N 1R120706-0003, Revision B) 5-11

Performing a System Bakeout
The system bakeout of the mass spectrometer removes unwanted gases 
or molecules (collected or remaining) from the high vacuum region of 
the instrument. Ions can collide with those gases or molecules resulting 
in lower overall sensitivity. Therefore, Thermo Fisher Scientific 
recommends baking out the instrument if the high vacuum decreases 
noticeably during routine operation.

Bakeout is mandatory after maintenance or service work is performed in 
the analyzer region where the system is vented. You should bake out an 
instrument that has been vented for at least twelve hours (12 hours) 
before you can start using it again.

In case the system has been vented during a power failure, it is necessary 
to bake out the system to obtain the operating vacuum.

NOTICE Before you start the bakeout, ensure that the pumps are up and 
running at their operating speed. If you have just switched on the mass 
spectrometer, this will take about 10 minutes. To check the pump speed, 
open the Instruments Status window and expand the Vacuum System 
node of the Instrument tree. ▲

❖ To perform a system bakeout

1. In the Q Exactive GC Tune window, click on the On/Standby 
button to put the instrument in Off condition. (See image in 
margin.)

2. In the Tasks panel, click  to 
display the Vacuum / Bakeout window.

3. Enter the desired baking duration (in hours) into the spin box. The 
range is 4 to 100 hours. See Figure 5-6.

Figure 5-6. Vacuum / Bakeout window
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4. Click Bake out. A dialog box shows the duration of the baking 
procedure. See Figure 5-7. Click Yes to confirm the message.

5. The message box disappears and the baking procedure starts. The 
instrument indicates the active bakeout procedure by a flashing 
Vacuum LED at the front side. Additionally, the Q Exactive GC 
Tune software displays a corresponding message box.

6. The baking of the instrument stops after the preset duration. The 
Vacuum LED keeps flashing until the cooling and stabilization time 
(of about 3 hours) is finished.

Click Stop in the Vacuum / Bakeout window to abort the baking 
routine before the preset time.

Figure 5-7. Bakeout message box
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Changing Default Settings of Q Exactive GC Tune
With exception of standard users, users can use the instrument status 
window to change default settings of Q Exactive GC Tune.

Displaying the High Vacuum Readback

The High Vacuum readback in the Vacuum / Bakeout window is visible 
only when the ion gauge in the high vacuum chamber is switched on. 
With exception of standard users, users can switch on this gauge 
manually.

❖ To switch on the High Vacuum readback in the Vacuum / Bakeout 
window

1. Click  in the tasks 

panel to display the Vacuum / Bakeout window.

2. If the instrument status window is not visible, choose Windows > 
Instrument Status.

3. In the instrument status window, click Instrument > Vacuum 
System.

4. Right-click the High Vacuum parameter to display the shortcut 
menu.

5. Choose Turn on to switch on the ion gauge in the high vacuum 
chamber.

6. The Vacuum / Bakeout window now displays the High Vacuum 
readback.

To extend the lifetime of the ion gauge in the high vacuum chamber, it 
is switched off again after a preset time of about thirty minutes.

Contents

• Displaying the High Vacuum Readback

• Performing a System Bakeout

• Changing Default Settings of Q Exactive GC Tune
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Changing the Settings for the Performance Status Check

By default, the performance status icon on the toolbar turns yellow 
25 hours after the last successful mass calibration or check. With 
exception of standard users, users can change this value in the System 
node of the instrument status window according to their mass accuracy 
requirements.

❖ To change the settings for the performance status check

1. If the instrument status window is not visible, choose Windows > 
Instrument Status.

2. In the instrument status window, click Instrument > System > 
Configuration settings > Performance Check. The Mass 
calibration due time (h) field displays the current validity period of 
the mass calibration (25 hours, for example). See Figure 5-8.

3. To change the value, right-click the number in the text field to 
display the shortcut menu.

Figure 5-8. Instrument status window—Performance Check node
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4. In the Set text field, enter the new validity period (40, for example). 
See Figure 5-9. You can enter a value between 1 and 500 hours.

5. Press the <Enter> key to confirm your input. The shortcut menu 
disappears and the new value is displayed in the instrument status 
window.

Figure 5-9. Changing the calibration validity period
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Chapter 6 Reference Information

This chapter provides reference information for the following:

Contents

• Log Files

• Tune Files and Calibration Files
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Log Files
Log files (*.log) are created for a Q Exactive GC mass spectrometer. The 
default directory for the log files is C:\Xcalibur\system\Exactive\log. 
The Instrument Configuration window shows the actual path.

Additional log files are created every time the Exactive window service 
starts. The file name shows date and time of the service start, as shown 
in the following example:

Thermo Exactive--2015-10-05--15-17-05.log

NOTICE The system automatically deletes all log files that are older than 
18 months. ▲

Each line in a log file is a message. A message has several properties that 
are listed at the beginning of the line, followed by the message body.

Properties are enclosed in brackets. A property is a property name 
followed by an equal sign followed by the property value. These 
properties exist:

Access to the log files is regulated by the Microsoft™ Windows user 
account or group account. Full access to the log files is granted to 
Administrators. Members of the Power User group can read, delete, and 
modify these files. Standard users can read these files.

Abbreviation Meaning

Time Time of the message. The current local time is displayed 
followed by the time offset to UTC.

Acc Windows™ account name that caused this message; 
“(none)” is used for an instrument source. Other known 
values are “ExactiveUser” and “Xcalibur_System”.

User User name description of the Windows account

Comp Computer name on which this message was caused, 
“(none)” is used for an instrument source.

App Application name that caused this message; “(none)” is 
used for an instrument source.

PID Process identifier of the application process

Inst Instrument affected

Conn Connection in charge for the communication with the 
instrument

Type Type of the message. Message types are “info”, 
“warning”, “error” and “FATAL error”
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Tune Files and Calibration Files
Tune files and calibration files contain information for operating the 
instrument.

Tune Files

Tuning optimizes voltage settings to ensure highest sensitivity. The 
resulting tune file (*.mstune) is specific to a particular analyte and its 
analysis settings.

During installation of the instrument, the service engineer creates a tune 
file default.mstune in the folder C:\Xcalibur\methods\. Use this file as a 
starting point for optimizing the mass spectrometer for your specific 
measurement requirements. Use this folder to store your personal tune 
files.

Calibration File

After having tuned the Q Exactive GC mass spectrometer, calibrate the 
instrument to ensure the mass accuracy of the measurement results. 
Calibration parameters are instrument parameters whose values do not 
vary with the type of experiment. They are stored automatically in a 
calibration file (*.mscal) in the folder 
C:\Xcalibur\system\Exactive\instrument\msx_instrument_files\.

The file master_cal.mscal contained in this folder is the calibration file 
used for operating the instrument. It will be overwritten with new 
calibration values every time a calibration procedure is successful.

NOTICE Never save or change files in the folder 
C:\Xcalibur\system\Exactive\instrument\msx_instrument_files\! Files in 
this folder are automatically managed by the instrument software. ▲
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